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Preface

Welcome to the world of network-based video surveillance! Thank you for
choosing the multi-functional surveillance software SeeTec 5. This manual
provides information about the installation and configuration of the SeeTec 5
software as well as instructions on using the most common functions of
SeeTec 5.



About SeeTec

SeeTec has been a value-added distributor for network-based video
surveillance since 1997.

Value-added distribution comprises network cameras and video servers of
leading manufacturers such as ACTi, ArecontVision, Axis, Basler, Convision,
Grandeye, IQinVision, Lumenera, Mobotix, Panasonic and Sony.

Furthermore, SeeTec develops sophisticated software for the use of video
servers and network cameras by various manufacturers, especially for
professional video surveillance with thousands of cameras.

Increasingly complex projects and requirements for more comprehensive
functionalities, security and scalability while at the same time ensuring
intuitive use have prompted SeeTec to modify and extend the SeeTec software
version 4, which became obsolete at the beginning of 2004.

In July 2004, a software solution featuring a completely remodeled user
interface and server structure that provides extensive functions especially for
alarm scenarios was introduced: SeeTec 5.



SeeTec 5

1 General information
1.1. Architecture

SeeTec 5 features a modular and network-based approach, i.e. all functions are
organized in modules that communicate via TCP/UDP and enable the scalability
of the entire system through shared installation on different computers.

A strict client / server architecture forms the basis for the new system.
Functionality is achieved on one or more cooperating servers - the client
modules only serve for visualization and/or administration, and configuration.
The most important system characteristics include:

e  Server services (32bit) for Microsoft® Windows® 2000 Professional
(SP3 or higher) / XP Professional / Server 2003 (SP1 or
higher) / Server 2008 and SuSE Linux Professional, version 9.X

¢  Client application (32bit) for Windows 2000 Professional (SP3 or
higher) / XP Professional / Server 2003 (SP1 or higher) / Server 2008

¢ Integration of hardware (video servers, network cameras, motion
detectors, etc.) by different manufacturers

¢ Integration of up to 1000 cameras per installation
. User management of up to 1000 users and/or user groups
. Comprehensive alarm scenarios

. High-performance database management with a throughput of up to
50 MB/sec. per server

. Encrypted network authorization
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Exemplary architecture overview with distributed server functionality and
Internet connection

Also see chapter 1.2 Module overview.
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1.2. Module overview

1.2.1 Administration services

The SeeTec5_ENT (EntityManager), SeeTec5_EVT (EventManger) and
SeeTec5_ALARM (AlarmManager) services along with the SQL database SAPDB
provide powerful services for the central management of the SeeTec
installation. If suitable hardware is used, up to 30 alarms per second can be
managed.

Applications with a large number of users or resources to manage require a
powerful user management that meets various criteria. SeeTec'’s
AuthorizationManager (SeeTec5_Auth) satisfies the following criteria to a great
extent and is thus an ideal solution for the management of large installations.

>

>

Encrypted and thus secure transmission of passwords via the network
must be ensured, especially for external Internet connections.

The client interface and functions available to the user need to
automatically adjust individually to the given user rights. With respect to
resources such as cameras, this means that only those cameras must be
available for selection that have been previously assigned.

The system must allow for easy and transparent management of a large
number of different users (maybe with high fluctuation of employees).
Multiple users can often be grouped due to identical requirements with
respect to access permissions. SeeTec 5 provides a superordinate group
concept to reduce the required administration effort to a minimum.

Log-in authentication of a client must be performed quickly to avoid
waiting times for the user.

Management of alarm data and events in the database requires high
performance to enable fast and easy access, if needed.

10
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1.2.2 CameraManagement (SeeTec5_CM)

The management of all cameras involved is the core of each video surveillance
solution. Network cameras and video servers feature much higher complexity
and heterogeneity than analog technologies. Reasons for this include:

= The analog signal is supplied in PAL to ensure a standard image format.
However, network cameras of different manufacturers use different image
formats (JPEG, Wavelet, H.264, MPEG-2/4, and other proprietary
formats). Some of these formats must be processed differently by the
software and also increase the integration effort and render client
visualization more complex.

= The network infrastructure used can reach from basic local network
configurations up to broad Internet or VPN networks.

In comparison to older versions, CameraManagement better pursues the
cross-manufacturer and cross-format integration of different hardware. Version
5 also integrates JPEG, MPEG-4 or H.264 and MxPEG cameras.

Each Camera Management module is able to manage up to 100 cameras
independent of the required image rates. Using the module on multiple
computers multiplies the number of cameras and thus also supports very large
installations with up to 1000 cameras. Compared to frame grabber cards of
analog systems, the performance in terms of image throughput is considerably
higher.

11
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1.2.3 MultimediaDatabase (SeeTec5_MDB)

Even small installations with few cameras require the database to handle a
level of image throughput that cannot be fulfilled with traditional SQL
databases such as DB2 or Oracle.

For this reason, SeeTec has developed a dedicated multimedia database
(MultimediaDatabase) with currently unmatched performance. Features of this
database include:

= Hardware and platform independent implementation (Java). Use with
almost every hardware, from commercially available PCs up to
midframe systems (e.g. AS/400). Supported operating systems
(32bit) include Microsoft® Windows® (all Professional and Server
versions) and SuSE Linux Professional, version 9.X. Use with other
Linux derivatives is also possible.

= The file-based approach supports the use of file systems such as FAT/
32, NTFS, and ReiserFS. The cluster size should be 64KB.

= Fail-safe RAID systems can be used on every level. Storage may also
occur in an SAN or NAS system.

= Throughput on a typical PC system with IDE boards amounts to
approx. 10MB/sec., which corresponds to about 600 images in CIF
format. Throughput can be extended to more than 50 MB/sec. if
suitable hardware is used (e.g. dual XEON system with RAID unit).

= Live backups (backups at runtime) are supported through many
configuration functions.

12
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1.3. System requirements

Performance requirements of SeeTec Server services primarily depend on the
video volume transferred and/or the storage hardware used. A desktop PC
with a 3GHz processor and local IDE hard disk can process video data of
approx. 10MB/sec., a powerful processor server with a RAID system can
increase the throughput up to a maximum of 50 MB/sec. As a general rule,
INTEL processors should be used as they provide a considerably better
performance when used with SeeTec than comparable AMD processors. At
least 512MB RAM and 5GB hard disk storage must be available.

Dimensioning the hardware for the SeeTec Client primarily concerns the
processor type and its performance. We recommend INTEL processors for
optimum performance. The socket for the SeeTec client should have at least
150 MB RAM freely available. An additional 20 MB are recommended for each
camera to be visualized.

Please take into account that the hardware requirements greatly depend on
the respective configuration.

Client requirements

. Operating system (32bit):
Windows 2000 Professional (SP3) / XP Professional / Server 2003
(SP1 or higher) / Server 2008

. Computing power:
Pentium4 (or similar) min.

. Main storage:
512MB RAM min.

. Hard-disk storage:
250MB

. Other:
Separate video card (avoid using integrated video cards if possible.
Do not used shared memory as performance would suffer
considerably.)

The client should feature a gigabit ethernet connection.

13
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Server requirements

. Operating system (32bit):
Windows 2000 Professional (SP3) / XP Professional /
Server 2003 (SP1 or higher) / Server 2008
SuSE Linux Professional 9.x

. Computing power:
3 GHz or higher (Pentium4 or comparable)

. Main storage:
512MB RAM min.

. Hard-disk storage:
2GB to 50GB+ storage for image recording
(50GB represent the maximum configuration - including log files,
backups and full extension of the SAPDB)

. Other:
The server must feature a gigabit ethernet connection.

14
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2 Installation

2.1. Installation information

15

Notes
If SeeTec 5 is already installed on your computer, you have to

uninstall it first (use Control panel -> Software).
All image and configuration files will be maintained.

Because of the SAP database used (SAPDB open source database,
used in SeeTec 5 as management and event database), the
installation path of SeeTec 5 may not include space or special
characters.

It is recommended to use a separate hard disk / partition for
image data. This approach guarantees that video data recording is
not influenced by external data. The storage available on the
operating system partition is constantly decreased by temporary
files, for instance. Also, other programs may access this partition
which in turn reduces database performance.

Read the SeeTec Administration / MultimediaDatabase (MDB)
chapter carefully to avoid false configuration and resulting system
errors.
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Important

Since several VB scripts are used for installation, we
recommend to deactivate any virus software during the
installation procedure.

SeeTec 5 may not be installed on a compressed drive as this
will cause problems with the SAP database. Also, do not
compress drives with an existing SeeTec 5 installation.

UDP is used to transfer image streams from server to client
(default: port 60007). During installation you will be
prompted whether this port should be opened in the
Microsoft Windows Firewall. Confirm this request with Yes. If
you are using software firewalls from other software vendors,
you have to open the port manually (also see chapter
Firewalls & SeeTec 5).

At the end of the installation process, DirectX is installed. If
there is no previous installation of DirectX, the system will
reboot after completing the installation. DirectX is required
for joystick control as well as MPEG-4/H.264 display and
must be installed. If at the end of the installation of SeeTec
an error message is displayed then DirectX could not be
installed. DirectX can be installed at a later time. You can find
the setup file in the "3rdPartyTools" directory on the SeeTec
DVD. Please use that version only.

It is possible that an error message is displayed during the
installation of DirectX on a Windows 2003 server which can
be ignored.

Symantec software products (Norton Firewall, Norton
Internet Security,...) should not be used on the SeeTec 5
server as these programs prevent communication between
server services.

16
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2.2. Standard installation

The standard installation is suited for individual workstations or host

computers in distributed installation environments. It contains the following
modules:

= SeeTec 5 Client

= SeeTec 5 Server services

Installing SeeTec 5

1. Insert the DVD-ROM into the DVD-ROM drive.

2. In this menu, select Install SeeTec 5.

3. In the InstallShield Wizard, select Standard installation.

The Startup menu does not appear.

Autorun is deactivated for your CD-ROM drive.

L #$ %
%

17
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2.3. Customized installation

With a customized installation you can install individual components on one
computer (for a distributed installation on multiple computers, see the next
chapter):

. Client

. Basic services

¢ Camera management and image database
. MonitorWall Manager

. MonitorWall Client

. Advanced service. If the advanced service is installed, basic services
also have to be installed on the same computer. Also see the manual
of the individual advanced services.

Important
In distributed installations, basic services may only be
installed on one computer.

18
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2.4. Distributed installation

Installation on multiple computers

A standard installation must be performed on the host computer first (also see
chapter Standard installation).

19

1.
2
3.
4

Start the installation on the secondary server.
Select the desired installation directory.
Select Custom in the dialog for choosing the setup type.

Only install the Camera management and image database
components and the client optionally.

Click on Next.

In the Start menu, execute
Start/Programs/Seetec/Seetec 5/Seetec Administration.

& Host name Port

Insert the and/or )8 of the host server. Do not
change the /

Quit the SeeTec Administration tool.

Note

For this type of installation, both installed services will not be
started automatically. You must start these services by using
Administrative Tools/Services under Control Panel or reboot your
computer.

For both servers to communicate and images to be displayed, a
continuous connection with an adequate bandwidth is necessary
between the main server and the distributed server. The required
bandwidth depends on the image data that is to be transferred.
Additionally, a bandwidth of 64kBit/s is required for server
communication.
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Important

Should the connection to the administrative services be
interrupted and not restored immediately, all distributed
servers are set to emergency mode:

Standard recording of all cameras on the distributed server
continues.

The following restrictions apply for alarm recording:

For complex alarm scenarios, preconditions are not
evaluated.

Within alarm scenarios, no outputs are mapped.

Alarms are not saved as alarm events, i.e. you cannot search
for alarms in the archive. However, the alarm recording is
displayed in the archive as alarm recording (= red time bar).

Alarm recordings are terminated only by the defined alarm
duration.

Recording gaps of 20 to 40 seconds occur when changing
from normal mode to emergency mode or back.

20
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2.5. Update installation

Note

There are two ways to update the SeeTec 5 software:

* There are patches for a system update.

* You have the complete software at your disposal.

Importing individual patches

3.

Stop the 14=service using Control Panel/Administrative
Tools/Services.

Extract the update file to the SeeTec installation directory and
overwrite any existing files.

Start the ! service.

Installing a new complete version

1.
2
3.
4

21

Perform a backup of the SAP database.
Save the conf directory of your current SeeTec installation.
Stop the 14=service.

Uninstall the current version in the Control panel under Software. All
image and configuration files will be maintained.

Copy the new license key to the conf directory of the existing SeeTec
installation folder.

Install the new complete version in the directory of the older version.

Note
If you perform an update to a newer SeeTec version, all

configuration settings will be maintained.
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2.6. Installation under Linux

Notes

SeeTec 5 supports the following distributions:
* SUSE Professional & SLES, version 9.x

* 2.6 kernel required

* 32bit platforms only

Other Linux derivatives may be used as well. Note, however, that
no installation support will be provided for these OS versions.

It is assumed that the Linux system is exclusively used for
SeeTec 5 and that no other production software is used on the
system.

A minimum installation with an X Window System must be
performed since it is required for the AdminTool. There are no
restrictions as to which window manager is used.

In addition to the SUSE minimum installation, the following
packages must be installed (or their installation must be verified):

e liblems ( ( 8%&)
e compat ( ( 8%&)
* libcat

* Zip

* unzip (required for installation procedure)
* sed

* awk
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Installing SeeTec 5

For installation, you need to be logged in as root or as a user with root rights,
otherwise the installation process will abort and an error message to the effect
will be displayed.

1.

Copy the file C % C ( ) to the /tmp directory, for

instance.

Unzip the file C % C (C ) using the command
%#) C % C C )

In the current directory, execute the script using the

command

./installer.sh

During installation you will be prompted to enter the kernel version
you use. This prompt will be followed by a comment in parentheses
similar to this one: (uname -r says: 2.6.11.4-20a-default). Make your
selections based on the value displayed.

$ $

5. Stop and restart SeeTec 5 using the following commands:

+
+

23

+
+

+ or
+

Notes
Only installed services will be started. The start script will

automatically detect these services.

During installation, the global parameter for the maximum number
of file handles is altered. The value is changed from the default
value (1024) to 65535.
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Installing a new complete version

For update, you need to be logged in as root or as a user with root rights,
otherwise the installation process will abort and an error message to the effect
will be displayed.

1.
2.
3.

Perform a backup of the SAP database (see chapter 5.3).

Save the directory of your current SeeTec installation.

Copy the file C % C ( ) to the + directory,
for instance.

Unzip the file C % C ( ) using the command
tar xvzf SeeTec_V5.x.y full_eng.tgz.

Copy the new license key to the directory of the SeeTec
installation.

In the current directory, execute the script using the

Jinstaller.sh command.

Select the Update option for the type of installation.

24
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Uninstalling SeeTec 5

Start the uninstaller.sh script, which you will find under the following path after

installation is completed: <SeeTec installation directory>/tools/Setup

Using the AdminTool

The use of this tool requires an X Window System, and you must be logged on
as root.

Start the AdminTool with the following command:
<SeeTec installation directory>/admin/bin/admin_console.sh

Installation is aborted with the following error message:
Install registry path "/var/.../config/install" dont exist cannot create
install registry file.

A complete installation already exists in the system.

Delete the /usr/spool/sql directory before installing again.

25
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2.7. License key

In order to allow for flexible scaling of your surveillance system, the number of
managed cameras and the client functionality are bound to a license key.

Note
= A key is only valid for the current and the previous version
while an update requires a new key.

Requesting a license key

If are setting up a new system and did not purchase the SeeTec.key license
key from a SeeTec distributor you can request a license key over the Internet.
1. In your Web browser, go to www.seetec.de/license.
2. Click on the Order a NEW licence key link marked in yellow.

3. Enter your installation number (INR), your personal data and the IP
address or host name of your SeeTec Server. You will find the INR on
your invoice or on the back of the DVD cover.

4. Click on Order Licence Key.

Your license key will be sent to the e-mail address you have stated in the
corresponding form field.

26
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What do I have to do if I have lost the license key?

In your Web browser, go to www.seetec.de/license.

1.

2. Click on the yellow Order licence key AGAIN link.
3. -~ Rl

4,

Order Licence Key.

Installing a license key

1. Save the old SeeTec.key license key in the path C:\Program
Files\SeeTec\conf.

Copy the new license file into this directory.

3. Restart all basic services (also see Chapter 2.8 Starting and
terminating basic services) or reboot your computer.

27
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2.8. Starting and terminating basic services

Terminating basic services

1. Open a services window and terminate the service
14=

2. Terminate the service 8%$& 44 4

Starting basic services

1. Open a services window and start the service
8%& 44 4

2. Start the service !

3. Wait for about 10 seconds before starting SeeTec Surveillance.

All other required SeeTec services are started automatically.

Starting and terminating basic services (Linux)

Terminate and start SeeTec 5 with the following commands:

+ o+ +
or
+ 4+ +

28
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2.9. Encrypted communication within the SeeTec 5
system

Communication between the SeeTec Server and the clients can be achieved
using TripleDES encryption which requires a corresponding license.

Configuration for encrypted communication

First, create a key pair.
To do this, execute the following

<SeeTec installation directory>/tools/generateKey/generateKey.bat
Provide your information in the next dialog and confirm with YES.
Example:

Your first name and last name
[Unknown]: John Doe

The name of your organizational unit
[Unknown]: IT

The name of your city or community
[Unknown]: Philippsburg

The name of your state or province
[Unknown]: Baden-Wuerttemberg
Your (two-letter) country code
[Unknown]: DE

Is CN=John Doe, OU=IT, O=SeeTec, L=Philippsburg, ST=Baden-
Wuerttemberg, C=DE correct?

[No]: YES

29
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The generated key pair is stored in the directory of the SeeTec installation
(file: ).
For distributed installations, this file must be copied to the conf directory on all

SeeTec servers. Distribution on servers should take place via secure
communication channels.

If a firewall is used you have to open the ports 60011 and 60012, as well.
These ports are used to transmit the key from the SeeTec Server to the SeeTec
clients and the SeeTec Server services (you can also change these ports in
SeeTec Administration).

You do not need to configure the clients. As soon as the file is
available, an encrypted connection between server and client will be
established automatically.

To enable the encrypted communication, restart all SeeTec services on all
affected servers.

Notes
Encrypted communication between SeeTec Server and client is

enabled when the keystore file is located in the conf directory of
the SeeTec installation.

To disable encrypted communication, delete this file and restart
SeeTec services.

Encrypted communication is also possible between a camera and
the SeeTec Server (currently only for Axis cameras). See chapters
Hardware / Image storage and Axis HTTPS configuration.

30
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2.10. Access data

By default, the SeeTec 5 software features an administrator user who will have
full access to the entire system.

Starting SeeTec Surveillance

1. In the Start menu under Programs/SeeTec/SeeTec 5/, click on
SeeTec 5 Surveillance.

2. Enter the following - : administrator
Enter the following 8 : pass

4. Click on OK.
Important

Change your password immediately after starting the system
for the first time in order to avoid unauthorized access to the
software.

All user names and passwords are CASE-SENSITIVE, i.e. a
distinction will be made between upper and lower case
letters.

There is no "back door" to the SeeTec 5 system.

If you forget the administrator password and you have no
user in the administrator group, you will be unable to access
the system!

When logging in via NAT, the Use NAT translation option must
be enabled during server selection.

When logging in without NAT, this option must be disabled
before login (also see chapter NAT)

31
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3 SeeTec Client

3.1. File menu

Important
The following settings must be performed for each client and
for each Windows® login profile!

Surveillance Mode, Archive Mode, Report Mode, Configuration
Mode, ATM, LPR, Retail and CIT Mode

See chapter 4.1

Changing passwords

1. In the File menu, select Change password.
2. Enter your new 8

3. Confirm your new 8

4. Click on OK.

Notes
You cannot change your password in Configuration Mode!

In Authorization Management you can withdraw the user's right to
change the password.

32
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Client configuration

In the File menu, select Client Configuration to change the client settings:

Language
Set the desired Language for the SeeTec Client.

The chosen Language will be adopted when rebooting the software.

Network

The ( option is used to increase request times in
Archive Mode. Consequently, no timeout will occur and no red beam will be
displayed in the player when performing large requests in Archive Mode.

The .$8 8/ determines the protocol and the port
used to transfer image streams of the cameras from the SeeTec Server to the
client.

If you use multiple independent SeeTec systems, you can Automatically
connect clients to backup server on network failure. To do so, select this option
and enter the = (or IP address) and the backup server /

1 the % when accessing servers with narrow-band connections.
First, double-click on the corresponding CameraManagement to select it.

In the following dialog you can adjust the maximum & used (in
kBit/s).

Client

Start client in fullscreen mode
Activate Start client in fullscreen mode to use the fullscreen mode.

Note

The fullscreen mode can also be enabled / disabled by using the

ESC key.

33
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Using Windows buttons
Button text may not be displayed at all or may not be displayed completely

under Microsoft® Windows® 2000. Activate Use Windows buttons to display
the button text in its entirety.

Suppress time lag to server warning
If there is a time lag of more than 10 seconds between client and server, a

message is displayed at login. You can suppress this message here.

Delete entities without affirmation in Configuration Mode.
If this option is activated, the respective entity (camera, time template, alarm,

button, etc.) is deleted without prior notification if you click on Delete in
Configuration Mode.

Using multiple time bars in the archive
Select whether you want to use the old or the new player interface in the

archive. If this option is enabled the new interface is used (also see chapter
Archive Mode).

Maximum number of alarms in Archive Mode /
Maximum number of events in Report Mode
You can alter the maximum number of alarms displayed in Archive Mode and

the number of events in Report Mode.

Alarm handling
This option is used to determine whether Most recent alarms or Older alarms

will be displayed first when processing the alarm list.

Joystick control
Activate Joystick control if you want to control a PTZ camera via joystick and

specify whether a biaxial or a triaxial joystick is used.

34
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VOIP & SIP

See chapter 7.1.6 SeeTec client configuration (extension).

Alarm suppression
You must first create a new alarm group in order to suppress alarms in
Surveillance Mode.
1. Click on New alarm group.
Add all alarms belonging to the group.

3. Finally, define under which circumstances no alarms are to be
displayed by placing a checkmark if the alarm should be suppressed
(digital input open or closed).

Change profile

1. In the File menu, select Change profile.

2. Select the desired profile and click on OK.

Note
= You cannot change the profile in Configuration Mode!

=>» In addition, there must be at least two existing profiles (user
and group profile) to be able to change the profile.
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Change user

1. In the File menu, select Change user.
2. Enter information for the new user.
3. Click on OK.

Note
You cannot change the user in Configuration Mode!

Connection to new server

If multiple servers are installed, you can establish a connection with another
server:

1. In the File menu, select Connection to new server.

2. Inthe 6 field, enter the name and/or IP of the server. In the 8
field, type in the port number (standard port: 60000) of the server.

Note

You cannot establish a connection with another server in
Configuration Mode!
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3.2. Layer menu

Important
The following settings must be performed for each client and
for each Windows® login profile!

Adding windows / layers

If multiple monitors are connected to a PC, you can add multiple SeeTec
windows.

In the Layer menu, select Add window and open the new window.
There are several ways to display the desired layer in the new window:

Temporary layer:

Right-click into the new window and select the Add layer menu.
Alternatively, select Add layer in the Layer menu. You can use drag & drop to
drag cameras, maps and web pages from the Camera overview to the new
layer.

Predefined layer, map or camera:
Use drag and drop to drag cameras, maps or layers from the Camera
overview to the newly created window.

Notes
Temporary layers will be deleted when restarting the client. If you

want to make the layers available permanently when starting
SeeTec 5 Surveillance, all required layers must be created in
Configuration Mode and must be assigned to a corresponding
profile.

Right-click to close the current layer or all open layers in the
current window (temporary layers only).
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Enabling / disabling fullscreen mode

The fullscreen mode can be enabled / disabled by using the ESC key.

Loading / restoring the user interface layout

In the View menu, you can load and save the user interface layout. You can
display or hide the following menus: Camera, Overview, Control, Buttons,
Patrol, Alarm list. You can also restore the standard user interface.

If some menus are not displayed, proceed as follows:

1. In the View menu, select the menu you wish to display.
2. Activate the Camera checkbox, for instance, by right-clicking once.
To save the user interface layout, select Save user interface in the View menu.

/ # $
Load user interface

Restoring the default user interface

In the 'View' menu, click on Restore default user interface.

Keep aspect ratio

Select this option to view the camera image in the original aspect ratio.
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3.3. Extras menu

The Extras menu is only visible in Configuration Mode.

Icon management

Icon management allows you to use your own icons for buttons, cameras,
maps, layers, web pages, or digital input.

Supported image formats are JPG, GIF, PNG, and BMP.

1. Open icon management and click on Add.

2. In the dialog, select the icon to import. The icon will be adjusted
automatically and will be shown as a thumbnail.

3. Click on Save to integrate the icon in the system.

Multi-configuration of video sources

In order to perform changes on multiple cameras at a time, select Multi-
configuration of video sources. A window will be displayed. Select the cameras
you wish to edit by clicking with the mouse or by using the CTRL key and the
mouse. If you select cameras by different manufacturers, you can only edit
those options that are identical for all camera types.

Change the > you want to adjust and confirm your selection by clicking
on the gray field containing the value in question. The field is now displayed
in green. You can apply your changes by clicking on Execute.

To terminate multi-configuration, click on Close.
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Image data multi-export
With multi-export you can manually save recorded image data from several
cameras at the same time.

Select the Multimedia Database from which you want to export (secondary
installation only). Mark the cameras (by clicking with the mouse or by using
the CTRL key and the mouse) from which you want to export image data.

Then activate the tracks that you want to export (Standard and/or alarm
image recording) and enter the time range for export in the and fields.

Additionally, enter a 8 for encryption of the image data.

Enter the 42/ / (Note: The export path must be available on the
corresponding SeeTec server) and start exporting with the Export button.

To terminate multi-export, click on Close.

Important
The export path must be available on the SeeTec Server for
automatic and manual export.

Exporting to a directory on the SeeTec client is NOT possible!
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3.4. Info menu

Viewing information about program version, users, host name, and port

Manual

Press F1 to open the manual.

Program

You will receive information about the program version and the logged-on user.
You can also verify the host name and port of the SeeTec Services.

License

Your license information is displayed (e.g. maximum number of cameras,
concurrent client connections).

System

Displays various system information.

Also see chapter 6.5 Reporting software problems
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4 SeeTec Surveillance

4.1. General

Almost all SeeTec 5 settings and the presentation of image data can be
performed through a client (SeeTec5 Surveillance). This client is the central
control and display unit of the surveillance system and is used for the
configuration of all SeeTec 5 Services.

Since all settings can be accessed through a single application, the
administrator effort is reduced (less physical travel, use of multiple individual
software modules).

Individual modes are listed in the main menu under the 0  option and can be
selected if the respective rights are assigned to the logged-in user. If this is
not the case, these functions are not displayed.

Due to the service-based approach, you do not need to start SeeTec 5
Surveillance to record image data. The recording process is launched
automatically when the server is started.

The client features four different modes, providing the user with a clear and
task-oriented perspective:

= Surveillance Mode
Archive Mode
Report Mode
Configuration Mode
ATM Mode

LPR Mode

Retail Mode

L 20 . T L 7

CIT Mode
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Surveillance Mode

This mode enables the display of "live" image data and/or incoming alarms
and supports camera control.

Archive Mode

This mode is used to visualize and export recorded image and event data.

Report Mode

In this mode, you can display and assess different events (alarms, user logon
and logoff, etc.).

Configuration Mode

Configuration Mode is used to specify all settings that are to be used and
executed by services.

ATM Mode (automated teller machines)

The ATM Mode is only available with an extended license.

Its field of application is the surveillance of automated teller machines and
cash recyclers. Transaction related video data that is stored in the archive
enables you to easily view business processes. For further information see the
manual for the GAA Mode.

LPR Mode (license plate recognition)

The LPR Mode is only available with an extended license.

Automated license plate recognition in the video image and matching against a
license plate database enables you to monitor driveways, control boom gates,
manage parking spaces and unloading areas as well as triggering alarms in
SeeTec 5. Alarm scenarios and records can be configured in detail according to
your needs using whitelists and blacklists. For further information see the
manual for the LPR Mode.
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Retail Mode (connection to retail cash register systems)

The Retail Mode is only available with an extended license.

This module provides an interface to cashier systems in stores and acts as a
link between business processes and the corresponding video image. By using
search parameters (e.g. receipt numbers, cancelations, revenues exceeding a
specified sum), you can search and view the corresponding image data in the
media database. For further information see the manual for the Retail Mode.

CIT Mode (cash in transit)

The CIT Mode is only available with an extended license.

The surveillance of counting stations is useful to ensure the correct course of
action during counting processes of large sums of cash. The counting process
is documented fully and consistently. The recordings stored in SeeTec 5 are
associated with individual transactions using the interface to the money
counting system's software and additional information is included. For further
information see the manual for the CIT service.
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4.2. Configuration Mode

In Configuration Mode, all hardware- and software-related settings of your
network-based video surveillance system are performed.

At the bottom of the client screen, you will find help texts for all tasks and
steps you perform in Configuration Mode with detailed information on
individual fields and procedures.

Administrator view Component overview

User view Help text

45



SeeTec 5

Starting Configuration Mode

You need to have administrator rights and the Master Client client type to
access Configuration Mode.

In the File menu, select Configuration Mode.

Administrator view:

This tree element shows all software functions and all included components by
category. It is only displayed in Configuration Mode.

Component overview:

This overview will change according to the component selected from the
Administrator view and will guide you through the configuration of individual
components.

User view:

This tree element will be displayed in Surveillance and Archive Mode and
allows you to map the organizational structure of your corporate resources.
Only those cameras and maps are displayed for which the logged-on user has
the appropriate access rights.

You can create new folders with the right mouse button, and you can file
included hardware components to the respective directory using drag & drop.
Help text:

This field contains explanations for each component selected in the
Administrator view to support the administrator in setting up the surveillance
system.

46



SeeTec 5

4.2.1 Hardware / Image storage

The Hardware option lists all components presently included, e.g. cameras,
video servers or input / output devices.

Network cameras consist of a camera unit and a video server unit. For this
reason, the Hardware option also lists the video server followed by a camera,
which is appended below. Consequently, the settings of a network camera are
also listed separately both as video server settings and as camera settings. In
the video server settings, all connection-specific parameters are defined. The
camera settings feature all settings related to image quality and image

storage.

Adding new hardware components

47

Click on Hardware.

In the Component overview, click on New and enter the = of the
component you wish to add.

Select the of this hardware component.
Select the "/ .
Enter the )8 or6
Confirm with OK.
Note

The IP installer button retrieves the previously selected IP
installer program of the camera manufacturer.
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Copying hardware

An existing camera or similar hardware component can be used as a template
for adding cameras.

The cameras must be of the same type as the basic cameras.

1. Select the camera in the Component overview.

Click on Copy.
3. Change the camera name and confirm by clicking on OK.
1 # #
4. Edit the camera to change the )8 and/or the 6 as
well as the internal = of the copies (see Changing settings

below).

Changing settings
Select the hardware component and click on Edit. Alternatively, double-click

on the hardware.

Depending on the hardware, you can perform or modify the following settings:
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IP camera / video server configuration

General

49

Note
You can always change every setting except the camera type itself.

You can change the = of the camera.

The ; 8/ (Real-Time Streaming Protocol) is used to transmit
control signals (only supported for Axis, Arecont Vision, Panasonic BD
and Basler cameras recording with MPEG/H.264).

You can check if your input in the 6 and 8 fields is correct using
the Browser button.

Axis cameras: If the camera model supports SSL connections you can
select whether the camera sends images to the servers without
encryption (HTTP) or with encryption (HTTPS). For HTTPS
communication, you need to generate a certificate for the camera
(see chapter Axis HTTPS configuration in the Appendix).

The 8) is automatically detected. If you are unable to use
your existing API version, contact us for a list of possible API and
camera firmware version combinations.

If you are using a distributed installation (combination of multiple
SeeTec servers), enter the that will
manage the camera.

If the camera can only be accessed using a password, activate
Authorization and enter the . and 8 for camera
access.
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Digital input / output

Activate digital inputs and outputs in order to process incoming signals on the
video server (Digital input), or to change the status of the Digital output.

Notes
For Digital input, you need to specify actions in the Alarm

scenarios tab that are to be applied when a signal is received.

You may add a Digital input to the Map to graphically display the
current input status (open or closed). In the Image field, you can
determine the ) that will be displayed.

You can change the Digital output status either using the button or
an alarm scenario (Server menu item).

Digital inputs
Activate the Digital input and enter a unique label in the = 1? 4 and
= ?84= fields.

To prevent the evaluation of every single signal for several signals in short
intervals which would lead to an unnecessary use of the event database you
can specify a duration in seconds in the $ field after which a new
signal is accepted as an event.

TCP alarm ports

Using the appropriate settings, video servers can often be configured to send
TCP signals (alarms), e.g. when a motion detection event occurs.

TCP alarm ports are not supported any longer since version 5.1.x! Under
Hardware, create a SeeTec Network I/O to tap the TCP ports of the cameras
(also see chapter 7.14).

Digital outputs
Activate the Digital output and enter a unique label in the = 1?7 4

and = ?84= fields. The hold period is the time at which the output is
opened or closed (0 = infinite).
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Camera configuration

Notes
The following options can only be configured if the camera

provides the corresponding interfaces.

If the fields are disabled, the setting needs to be modified directly
on the camera.

General

The camera description entered in the = field and the selected icon are
displayed in Surveillance Mode.

In the Properties field, select the Streaming

(Motion JPEG / MPEG-4 / H.264 / MXPEG) and Display mode (Auto / Fill
Container). The Auto display mode only applies for Mobotix cameras. It
provides faster scaling (and display on the client) of the camera image but the
image quality decreases.

The Camera type, Video input and Camera ID fields are relevant for analog
video servers only. Do not modify these fields unless you modify them on the
video server first.

If the image is colorless or contains too much color, you can change the
camera’s color profile in the field (optional, depends on the camera
type). If desired, you can display , Date and time in the camera image.
Date and time information is transmitted directly by the camera, not by the
SeeTec Servers (optional, depends on the camera type).

The Pan / Tilt mode only applies to PTZ cameras, see chapter PTZ control.
Additionally, you can set the control Sensitivity for continuous control.

If a camera is mounted upside down, turn the camera image by 180°.

The Invert arrow, Camera control and Camera positions options are only
relevant for PTZ (pan / tilt / zoom) cameras:
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In Surveillance Mode, all PTZ cameras are controlled using the PTZ control
panel. Since this can cause discrepancies if cameras are mounted upside
down, the directions of the arrow keys can be inverted using the Invert arrow
keys option. If the Camera control and Camera positions options are
deactivated, the user will no longer be able to control the camera with the PTZ
control panel and/or move to preset positions in Surveillance Mode.

Also see chapter PTZ control.

The Inactivity action is only relevant for PTZ cameras as well. If the Inactivity
action is enabled, you can trigger an Action with the Edit button after the
specified (camera is no longer controlled / camera will not move to
PTZ preset positions):

. Start or stop alarm recording
*  Move to preset positions

. Open or close digital output

The Action on start of video streaming is triggered when a user has the
camera in Surveillance Mode on top, i.e. the user is viewing the current live
image of this camera. As an action an output can be opened or an alarm
recording can be started, for instance. The Action on stop of video streaming is
triggered when the current camera is closed or another layer is brought on
top.

If more than one user is viewing the same camera, then the first user triggers
the start action. The last user to close this camera triggers the stop action.

If a camera is no longer available in the network, you can trigger an Action on
network failure:

Click on Edit and select the desired Action (open / close digital outputs,

start / end alarm recording).

MPEG / H.264 audio settings

Activate the MPEG / H.264 Audio option and select the corresponding camera
and audio codec in the MPEG / H.264 audio parameters to record the audio
stream.

If you want a user in Surveillance Mode to listen to the audio stream, you must
be assigned the corresponding right in Authorization Management.
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Image storage

All data on image storage, e.g. the image database to be used and the amount
of hard disk space to be used by the camera, are configured here.

To avoid overwriting sensitive image data, standard and alarm image
recordings are processed separately.

Note
Standard recordings are indicated by a green square at the lower

right border of the camera image in Surveillance Mode. During an
alarm recording the square will turn red.

$ %

If you are using multiple image databases, this selection list is used to specify
for each image source on which computer image data is to be stored.

The Info button displays all image settings of the standard and alarm
recording as well as the load of the multimedia database for this camera.

The Image storage for Standard recording and Alarm recording options for
camera configuration offer the following possibilities:

Activated:
Enable standard and alarm image recording

Frame rate:
Indicates the number of frames per second to be stored in the above stated
image database.

; / (standard recording only):

This option is used to specify the recording period in detail. The time range is
defined through a template that is created using the Time Management option.
The default is set to continuous recording.

Alternatively, you can set Standard recording to be activated only if a digital
input is opened or closed. Select the input by clicking the Edit button.

For details on image quality, you can use the Image parameters ;

and / D" for Motion-JPEG streaming and/or the Streaming
parameters )E5 "and & 3& 1 " for MPEG-4 and
H.264 streaming.
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In the Resolution selection list you can specify the image size (in pixels) that is
read from camera during standard recordings.

The following applies to MPEG-4 and H.264 streaming:

Important
MPEG-4 / H.264 streaming is manufacturer-specific and thus
not supported by all cameras.

Avoid parallel camera access during MPEG-4 /H.264
streaming in any case!

For ACTi MPEG-4, set the
20 ! value on the camera to

The frame rate is not indicated on Panasonic cameras. To
limit the image stream, change the bandwidth setting in
2 *

For a client side display of MPEG-4 / H.264 streaming the
screen saver must be deactivated.

Always keep the graphics card drivers installed on the client

updated.
If the values for ; F / F)ES F
& during alarm recording differ from the standard

recording the video stream needs to be reloaded. This can
lead to a recording outage of at least one I-Frame distance.

The )E5 value stands for the distance in seconds between two full
screens. Only image changes are transferred between full screens. With
& 3& 1 " you can define the image stream compression between

camera and SeeTec Server. By default, the image stream is compressed to
4096 kBit/s.
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The following applies to Motion-JPEG streaming:

Using the / D" field you can manipulate the actual image size
and resolution of image details in percent. The higher the compression
percentage, the smaller the image size. However, the resolution of image
details will decrease in individual frames. We recommend to set the
compression to at least 50% since a lower image compression ratio in Report
Mode could lead to server overload when writing the images in the image
database.

) + 1 (

You can define the image storage size for both tracks and also specify a time
limit for storage. When specifying the storage size in MB, the system optimizes
the use of the disk space stated in the MultimediaDatabase. If the available
storage space for images has been used up, the most recent recording will
overwrite the oldest recording.

Notes
If the required storage space exceeds the storage space defined in

the database, the image database will stop recording and will
notify you by e-mail or SNMP.

Each camera requires a minimum of 512MB free image database
space for internal management processes.

8 E =

Enter a time range (3600s max.) to record a certain time range of an alarm
recording before the alarm was triggered. This time range can be specified in
an alarm scenario as the maximum pre-alarm duration. If standard recording
is enabled, the pre-alarm duration from the standard track is transferred to the
alarm track.

2 / =C
Alarm recordings can also be initiated using the Start / Stop buttons. In case
you forget to stop an alarm recording, the recording process is automatically
terminated after the specified time range in order to avoid continuous alarm
recording.
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Important

The maximum post alarm duration does not have any impact
on alarm recordings that are triggered by an alarm scenario!

Alarm recordings can also be initiated by right-clicking in the
corresponding camera image.

Time-controlled recording
Using Standard image recording you can specify the quality (frame rate and
size) and specify the recording periods for the camera.

The exact time range is defined with a template that is created using the Time
Management option. The default is set to continuous recording.

Alternatively, you can set Standard recording to be activated only if a digital
input is opened or closed. Select the input by clicking the Edit button.

Alarm-controlled recording

To record the alarm track, you have to define an alarm scenario first (also see
chapter 4.2) so that one camera only starts recording image data in case of an
alarm. The validity for an alarm is defined with a time template in the alarm
scenario.

Define the quality (frame rate and size) of the recording using the Alarm
image recording option.

56



SeeTec 5

Camera positions

1. Move the camera to the desired position using the PTZ control panel
(also see chapter 4.3).
Set the zoom factor.

3. Click on New.

4. In this dialog, specify any given name for the 8 / The
name may not contain spaces and/or special characters.

5. Click on OK.

Image export

The image export stores the image data with encryption. The image data can
be viewed with the SeeTec OfflineViewer on a PC without SeeTec installation.

You will find the installation files and the OfflineViewer manual under
<SeeTec installation directory>/tools/OfflineViewer. During export, the
OfflineViewer installation file and a CD/DVD burning tool (Totally Free Burner)
are also copied to the export directory.

Alternatively, you can incorporate exported image data in an existing SeeTec
system by creating a directory (Hardware, : SeeTec, “/
Archive).

Also see Configuring the SeeTec archive.
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Automated image export

Select the Track you want to export automatically (standard and/or alarm
track). Specify the time range to export using a / and selecting
the desired settings. Use the Time Management option to create a time
template.

Specify the time of export, the password for encryption and the export path
using the Server — MultimediaDatabase — Image data export —
Automated image data export option.

Manual image export

Select the track you want to export (standard and/or alarm track). Specify the
time range to export (fields 5 and )andentera 8 for
encryption.

If the Use password from MDB option is enabled, the password from the
Server — MultimediaDatabase — Image data export —
Manual image data export option is used.

In the 8 field, enter the complete path for export.

To start the export, click on Export.

Important
The export path must be available on the SeeTec Server for
automatic and manual export.

Exporting to a directory on the SeeTec client is NOT possible!
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SeeTec motion detection

If the camera does not provide integrated motion detection functions, you can
activate SeeTec motion detection. However, we recommend to use camera-
integrated motion detection whenever possible in order to keep the system
load of the SeeTec Servers to a minimum.

To activate motion detection, first use Edit... to determine the number of
areas to be monitored. Different areas are needed only if various alarm
scenarios are to be triggered for each individual area. Change the = of the
area and the $ . The dead time is the time at which no other incoming
signal is accepted after the first incoming signal.

Use the mouse to highlight the area of the camera image for motion detection
(left mouse button to select, right mouse button to cancel the selection).

The Start test and/or Stop test buttons serve to check all settings. All
amplitudes above the threshold line in the test field are recognized as motion.
To precisely set motion detection Sensitivity, move this line up or down.

Important

Se€Tec’s motion detection feature can only be activated and
configured if the camera delivers single frames, i.e. if the
streaming mode Motion-JPEG is selected in the General tab of
the Camera configuration screen.

The motion detection feature only delivers suitable results for
motion detection in internal spaces.

Mobotix cameras are currently not supported.

For each active motion detection process, approx. 400MHz of
CPU power are needed on the SeeTec Server.
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Camera motion detection

Camera motion detection is only available for Axis, Sony and IQinVision
cameras supporting motion detection. For all other cameras with motion
detection, you must fill in the SeeTec Network I/0O field (also see chapter
Sample alarm scenario configuration).

Access your camera with a Web browser and specify the windows you want to
use for motion detection (see Appendix).

Activate the corresponding number of windows and enter a = and the
$ . The dead time is the time at which no other incoming signal is
accepted after the first incoming signal.

Important

If the "Unattended Object" detection mode is set for a Sony
camera, the corresponding dead time should be greater than
Release time minus Detection time. Otherwise, more than
one notification per detection is triggered.

Video gateway / Multicast

If an intelligent image evaluation is executed by a via:sys box from V.A.S.
GmbH, # the Gateway and specify the 8 . Through this port, camera
images are forwarded from the SeeTec server to the via:sys box.

Activate Multicast streaming and enter the desired Multicast IP and
/ to be used for image transfer from the camera to the client.
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Privacy masking

Mask sensitive areas or movements in the image to prevent users from
viewing these areas. Masking is displayed depending on the user rights in
Surveillance and Archive Mode.

1. Activate Privacy masking.
2. In the Privacy masking parameter, select a Method:

Static objects:

With this method, you can mask single areas of the camera image. To change
the Color of mask, click on the color icon below and select the color.
Additionally, you can enter a / " D. To create a mask, hold down
the left mouse button and drag a mask. You can select the shape (rectangle,
circle,...) by clicking the right mouse button.

Moving objects:
With this method you can mask all moving objects or persons. For example, if
a person in the image stops moving, masking is immediately canceled.

Office mode:

This method differs from the moving objects mode in one detail. If a person in
the image stops moving, masking is NOT canceled. For this method, a
reference image needs to be specified. Click on Load reference image.

The Clear history button deletes all older masks in Archive Mode if you
previously deleted and created new masks.

Important

Masking only affects users that do NOT possess the privacy
masking right in Authorization Management. The mask is not
displayed for other users.

In Surveillance Mode, administrators may right-click in a
camera image to enable or disable masking.

The mask is NOT exported during image export.

Privacy masking is not supported for Mobotix and Grandeye
cameras.
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Configuration of input / output devices
. Create new hardware, specify a = , and select the
(Beckhoff or Advantech).
. Select the "/ and click OK to confirm.

*  To modify the device (change the names of digital inputs and outputs)
select them in the Component overview and click on Edit.

General

In the General menu you can change the = ,)8 and/or the
6

Select the for managing the device (only if

multiple SeeTec Servers are installed).
Digital input / output

1. Define the number of digital Inputs and/or Outputs in the respective
menu by clicking on Edit.... For Beckhoff devices, the maximum
number of inputs / outputs is 32. For Advantech devices, the number
of inputs and outputs varies depending on the type.

2. Activate all required inputs and outputs, enter a name, and click on
OK to confirm.

Note
To be able to address Beckhoff PLCs in the SeeTec software, a

special program needs to be installed on the PLC by SeeTec.

You may add a Digital input to the Map to graphically display the
current input status (open or closed). In the Image field, you can
determine the) that will be displayed.

62



SeeTec 5

Configuring the SeeTec Network I/0

This device type enables you to carry out all network-based input and output
operations via TCP and/or HTTP.

*  Create new hardware, specify a = for the network I/0, and select
SeeTec as and Network I/O as the "/ .

*  To modify the network I/0, select it in the Component overview and
click on Edit.
General

In the General menu, you need to specify the IP addresses (and/or IP address
ranges, permitted IP addresses) from which to accept input operations. This
specification is not mandatory. You can list any given number of address
masks separated by commas (without spaces). Within an address mask, use of
the

wildcard characters * and - is allowed. If no address mask is assigned, every
incoming connection is accepted.

Example:
34456 78$34 45 9%367 - : :
In this example, three IP address masks were defined to restrict IP access:

¢  The address mask 10.0.8.9-23 permits connections from all IP
addresses between 10.0.8.9 and 10.0.8.23.

* The address mask 10.0.8.7 permits connections from this individual
IP address.

e  The mask 192.*.* * accepts connections from the entire subnet
starting with 192.

Select the for managing the network I/O (only if
multiple SeeTec Servers are installed).
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Output configuration

With Edit... you can define any given number of network outputs.

1. Activate the output and enter a =
2. Available protocols are TCP and HTTP. Select a 8

3. Enter the IP address to which the output will establish a
You can also bind multiple outputs to the same IP.

4. Specify a 8

Optionally, you may specify a - anda 8 as well.
6. Enter 2 in )) or hexadecimal (64@) format that is transferred.
Examples:
" 3& ; 34 4 5 338<933
74 : 34 4 3 37 &7 444
, + -3 $8
,= 87 §$>"7.
" 8¢& > ;@" 34 4 < 88854 1TA
+ % + + ) B c=8, %
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Input configuration

With Edit... you can define any given number of inputs.

Activate the input and enter a =

Incoming signals can be processed as follows:

"%

65

The SeeTec server passively waits for a connection request of an
unknown network device while the permitted IP address ranges are
checked.

The SeeTec server actively establishes a network connection (with the
HTML or TCP 8 ) using and 8 for addressing. The
connection is maintained continuously, and incoming data are
interpreted, i.e. they are compared with the 2 field. If the Text field
is empty, every incoming byte is considered an input trigger. The

$ is the time at which no other incoming signal is accepted
after the first incoming signal. Optionally, a - and 8

may be assigned.

&
3& # >
37444 D # $

# , .

78& # # 38444
# >
8& # #
34 4 < 8885454 # ;
E Text #
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Creating a TCP alarm port

*Use Edit... to add an input.

*Activate the input and change = ,8 and $ (the dead time is
the time at which no other incoming signal is accepted after the first

incoming signal).

Leave all other settings unchanged!

Note

The software provides an auto increment functionality to fill in port
data automatically. Enter a 8 , right-click the port field and
confirm the auto increment prompt with Yes.
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Configuring the SeeTec archive
With the archive you can integrate exported image data in a SeeTec system
and access it in Archive Mode.

Create new hardware, specify a = for the archive, and select SeeTec as
and archive as the "/ .

To modify the archive, select it in the Component overview and click on Edit.

General

In the General menu, specify the and the

$ % that will manage the archive images. Please take
into account that the exported image data must be available on the respective
SeeTec server.

Enter the 8 where the image data is located on the server.
Click on Re-read path.

The field now displays cameras that are located in the
specified path.

To verify the cameras, enter the password in the 8 field that was used
to encrypt the image data and click on / / . The cameras are now
displayed in the field.

If you used different passwords, enter them one after the other.

The cameras are now displayed as <camera name>[archive] in Archive Mode.
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Time management creates time templates that are similar to a timetable to
chronologically coordinate the standard image recording of one single or
several cameras as well as the validity of events.

Creating time templates

. Create a new template and specify a =

. Modify the template by clicking on Edit or by double-clicking on the

newly created template.

White areas represent recording stops, while blue areas represent
recording periods. To specify a time range, click into the time
template. To save time, you can select entire time ranges or
weekdays by clicking on the upper and lower edge.

* In the System Management under Work center calendar, you can
specify the days to be treated independent of normal weekdays in
time templates. These days are displayed in the time template as
holidays.

Notes
Please remember:

= White area -> function is disabled

= Blue area -> function is enabled

If a camera already references a time template and this template
is deleted, the camera starts continuous recording.
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4.2.2 Maps

To obtain an overview of the premises to be monitored and/or the installation
location of the cameras, you can insert maps in the following formats: BMP,
JPG, JPEG, GIF, and PNG.

Generating maps

1. Generate a new map and enter a =

2. Edit the map and select a Background image.... You can also select
a symbol for the map.

3. Select the desired object (camera, button,...) from the list.

4. Use drag & drop to insert the selected object at the desired map
position.

/ # F

5. Set the text of the inserted symbol to Always on or to Only on for
mouse over.

Note
You can place cameras, buttons, digital inputs, layers, web pages
and other maps on the map, but you cannot insert video servers.

69



SeeTec 5

4.2.3 Layers

You can display multiple cameras in one window by defining layers. Cameras
web pages or maps are then added to the layers via drag & drop. The user
interface can thus be customized to meet your specific requirements. The
following layer formats are available:

1x1, 2x2, 2x3, 3x3, 3x4, 3x5, 4x4, 4x5
and

1+2, 143, 145, 146, 148, 1+12, 2+8

4

All layers can be assigned to a user or group profile and will be available when

the program is started.

Note
You can also generate layers directly in Surveillance or Archive

Mode. To do so, select Layer / Add layer. Select the desired layer
format.

All layers are only temporary and must be generated again when
starting SeeTec 5 Surveillance the next time.
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Generating layers

Create a new layer, specify a = , and select the "/ .

Click on OK.

Edit the newly created layer and insert cameras, web pages and
maps from the user view using drag & drop.

Confirm with OK.

Assign the layer in the respective user or group profile under Profiles
if the layer is to be displayed when starting the client.

Important

Currently, a maximum of 20 cameras can be displayed in one
layer at a time. If you want to display more than 20 cameras
synchronously, you need a suitable graphics card and an
additional monitor. Please keep in mind that high frame rates
with larger image formats (>320x240) generate high
workloads on the SeeTec client!

Simultaneous display of cameras with MPEG-4 streaming is
limited to 80 cameras.
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4.2.4 Authorization Management

Creating a new user

1. Change to Open Authorization Management.
2. Click on User.

3. Create a new user. Specify a = anda 8 . Optionally, you
can use a secure password for the user. A secure password is at least
8 characters long, contains at least one upper, one lower case
character and one number. Special characters are also allowed.
For each user a user profile is automatically created.

Also see Rights management.

Creating user groups

If you need to create multiple users with identical rights, we recommend
generating a user group first and then assign the users to this group. In this
way, you can add or withdraw rights for multiple users at a time, which greatly
reduces configuration effort.
Creating a group

1. Change to Open Authorization Management.

2. Click on Groups.

3. Create a new group and enter a = . For each group a group profile
is automatically created.

Also see Rights management.

Validity of groups

In the Validity field, you can select time templates to define how many users
may work with group rights at a certain time.

In addition, group validity can be activated or deactivated by a Digital input.

Outside the group validity all assigned cameras, maps, etc. are hidden.
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Rights management

Basic rights management

Rights assignment in SeeTec 5 is strictly linked to the components you have
added. This means that you can permit or forbid individual users to use a
particular camera, button, or map.

Extended rights management

To specify in detail whether a user may for instance control a camera or only
use preset positions, you need to use Extended rights management. You can
add or remove specific rights by enabling or disabling certain options.

In addition, you can assign the right to use Report Mode and
Server extensions to a user.
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The symbols have the following meaning:

. View live images and web pages, use VoIP

. Control camera

. Control camera prioritized
. Move to preset positions
. Export images

. View recorded images and web pages in Archive Mode, listen to VoIP
recordings.

. Listen to MPEG / H.264 audio

. Privacy masks are not displayed
. Use maps

. Use buttons

. Use layers

Allocation of rights

1. Select the desired user / the desired group, and click on Edit during
the Allocation of rights.

2. Activate the respective right you wish to assign to the user / group.

3. Confirm your changes with OK.
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Important

If a user has been assigned to a group, thus inheriting group
rights that allow him/her to access specific buttons, for
instance, these rights cannot be withdrawn from the
individual user! Group rights are always inclusive.

The difference between user and group rights is only valid for
profile settings.

It makes no difference whether a user logs on with his or her
user profile or group profile. The user can always see all
cameras, maps, etc. that are assigned to him by user or
group rights.

If you created folders in the User view, you can also assign the respective
rights to the corresponding folders.
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Microsoft® Windows® Active Directory® support

Using Microsoft Windows Active Directory

1. Create a new group in the Active Directory.

2. Add the domain users to the group in the Active Directory that are
supposed to log on via the SeeTec Active Directory login.

3. Create groups in the SeeTec software that correspond to the
Active Directory groups. Please note that group names are case
sensitive.

4. Assign the desired group rights for the SeeTec groups in the SeeTec
software and Activate ActiveDirectory support

When starting the software users can now log on to the SeeTec system directly
with the Active Directory button without having to fill in the user name and
password fields.

To automate the Active Directory login enter the AutoADLogin command line
parameter in the link to SeeTec Surveillance (also see chapter Command line
arguments).

Note
You do not have to create user in the SeeTec software to log on via

Active Directory. The rights are allocated with the data stored in
the SeeTec groups.

Create a new group in Active Directory and add the corresponding
users. You need to create only the group in the SeeTec system.
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Password

Using secure passwords / changing passwords

A secure password is at least 8 characters long, contains at least one upper,
one lower case character and one number. Special characters are also allowed.

To force a user to use a secure password, enable the User has to use a
secure password option.

Specify whether the User is allowed to change password.

Changing user passwords

You can change a user password at a later point in time. In order to secure
access based on a double-authentication policy ("second set of eyes"), you can
assign a second password to a user which must be entered in the login dialog.

To do so, activate the User needs two passwords option, enter the second
password, and confirm with OK.

Setting password validity

To force a regular password change by the user, activate User may change
password and User must change password regularly and specify the >
of the password (30, 45, 60, or 90 days).
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4.2.5 Profiles

A Profile for each user and user group is automatically created. This profile can
be used to manipulate the display of live images in Surveillance Mode.

General

Type of client
Select the */

as follows:

that you want to assign to the user. The selection of
the client type depends on the client licenses. The differences of the types are

Door
Client

Just Watch
Client

Standard
Client

Master
Client

MonitorWall
Client

Surveillance Mode

X

X

X

PTZ control

X

Buttons

I/0 rights

Alarm processing

X | X | X

X | X | X | X | X

Report Mode

Map

Audio support

Archive Mode

X | X

Data import and export

Configuration Mode

Patrols

Industry solutions

X XXX | X[ X | X[ X | X|X|X]|X

The MonitorWall client may only be used for the

(]
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Locking the user interface

Activate the User must not change user interface option.

Consequently, the user will be unable to change main and additional windows,
position and size of docking elements (camera tree, buttons, control), and use
drag & drop to regroup layers or move them to another window. The user can
still execute all other functions (open, close and modify flyout windows and
create temporary layers).

79

Note
To avoid unintentional closing, the user needs to reenter his/her

password when terminating the client.

Beforehand, the administrator must specify the entire layout directly
on the client computer since the interface layout is locally stored on
the client PC for each client and for each Windows® login profile.

Paths:

Windows XP:

C:\Documents and Settings\<logged-in user name>\Local Settings\
Application Data\SeeTec5\conf\

Windows Vista:
C:\Users\<logged-in user name>\AppData\Local\Seetec5\conf\
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Timeout for prioritized PTZ actions

In Surveillance Mode, press F8 to activate prioritized camera control.

All cameras assigned to a user can only be controlled by him/her. If no control
is performed, camera control is released after

Prioritized camera control is only valid for those cameras that are currently
displayed. If you switch to another layer, prioritization of cameras that are no
longer shown is canceled. In addition, those cameras now shown are
prioritized.

Press F9 to enable camera control before timeout.

Note
The user must be assigned the right to use prioritization in
Authorization Management.

Assigning layers / patrols

The Profile can be used to specify which layers will be available to the
user / group profile created and which patrols may be executed.

To do so, click on Edit and assign the respective layer or the respective
patrol.
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Image settings

Single frame (Motion-JPEG streaming)

This option is used to specify the number of frames per second for the client to
display on each camera if the camera delivers Motion-JPEG images. There are
three modes:

Normal (camera framed in gray)

Selected (camera framed in green)

Alarm (camera framed in red)
Note

These settings only apply to client representations if the Motion-
JPEG streaming mode is selected in the General tab of the Camera
configuration screen. They are not related to the recording
process.

You can create different scaling types for the visualization of live images in
=?; 1, 414 4%,and 1 ; mode:
. & ( ": good image quality

. 6 / : approx. 15% faster, inferior image quality

Example:

* 3=4%374
544%=44$ % 0 $

Notes
These settings are not designed for image quality corrections or

improvements, e.g. image definition, noise suppression, lucency,
etc.
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Streaming (MPEG-4 / H.264 streaming)

In the Streaming group you can determine the 5 for MPEG-

4 / H.264 streaming. There are three modes:

Normal (camera framed in gray)

Selected (camera framed in green)

Alarm (camera framed in red)

In the streaming settings, you can choose between % and

5

With % 5 , the entire image stream is transferred. If more

than four cameras are displayed at a time and/or the computer hardware is
not powerful enough, this can cause heavy loads on the client PC.

With 5 , only I-frames (fullscreen) of the image stream are
transferred, which greatly reduces the CPU load of the client PC. The default I-
frames setting is 1 I-frame per second, i.e. with reduced frame rate, you will
only see one image per second in Surveillance Mode. You can change the
number of I-frames per second using the Image recording option in the
Camera configuration.
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4.2.6 Alarm scenarios

An alarm scenario defines actions to be taken in case of an alarm. Scenario
triggers include:

. Self-defined buttons
. Digital inputs
. Motion detection events

. External sensors

Creating alarm scenarios

1. Select the Alarm scenarios menu option.
2. Click on New.

3. Entera= for the alarm scenario.

4. Click on OK.

5. Double-click to edit the alarm scenario or click on Edit.

Subsequently, individual menu options of the alarm scenario are explained in
detail:
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General / Low-priority alarm settings

General

In the General window, you can change the alarm scenario (AS) = later on
and describe this scenario in detail. You can assign a priority to the AS using
the 8 * selection list.

There are three priorities: high, medium, and low. Alarms with higher priority
supersede alarms with lower priority. If an alarm is terminated, the original
layer is recreated. The differences in priority are as follows:

low alarm priority:
NO message window will be displayed, only the action specified under Client
(see below) will be executed.

If you have configured an alarm with low priority, you can Finish alarm on
client side, when alarm is finished on server side, i.e. it is terminated on all
participating clients and deleted from the alarm list. Starting an alarm (either
via an alarm scenario or a user clicking on the button) is not counted as
finishing the current alarm at this point.

When an alarm is finished, the next alarm is started automatically. Exception:
When postponing an alarm, no new alarm is started.

If you activate the Start new alarm on client side, when another low priority is
active option, an alarm with low priority will displace another active alarm with
low priority, i.e. the current alarm is postponed and the new alarm is
displayed. Deletion of the alarm from the alarm list must be explicitly
confirmed. If you want the alarm to be deleted from the alarm list
automatically when the alarm has ended, you must also activate Finish alarm
on client side, when alarm is finished on server side.

The layer set on the client is closed automatically when the alarm ends. To
prevent this, activate the Do not close layers automatically when an alarm has
ended option.

As a general rule, high priority alarms always displace alarms with low priority
and are immediately displayed.

Terminating an alarm on the client does not influence the server, i.e. alarm
recording will be continued.
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medium or high alarm priority:

As soon as an alarm occurs, a popup window will be displayed. You can specify
the text in this window under Client in the Alarm scenario option. In
Surveillance Mode, you can add a comment to the alarm in the popup window.
In addition, all actions specified under Client will be executed.

Notes
Since certain alarms are only valid at certain times, e.g. motion

detection alarms that are neglected during regular business
hours, you can select a time template for validity.

In the File / Client configuration menu in the Client tab you can
specify whether recent or old alarms shall be displayed first.

Validity

If you want the alarm to be triggered during a certain time range only, select
the corresponding time template in the Validity field. You can create time
templates in the Time Management menu.

Coloring

You can adjust the coloring of the alarm in the Alarm list in Surveillance Mode
by using the Text color and Background buttons.

Test

Use the Test button to initiate the alarm scenario for test purposes in order to
verify the configuration. If you have changed the alarm scenario, save it before
testing by clicking on Accept.
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Start (simple mode)

All triggers that initiate this event series are selected with the Start option of
an alarm scenario by clicking on Edit. You must create or activate triggers
prior to configuring the alarm scenario. The only exception are function
buttons that can be defined later on with Butfons. You can also start an alarm
scenario using these buttons. An incoming TCP signal from a camera
recognizing motion, for instance, can be a start event. This is realized via the
SeeTec Network I/0.

Start (expert mode)

The expert mode is only available with the appropriate license. With it you can
create complex alarm scenarios (the alarm is triggered by different
circumstances that can be linked with AND or OR).

First, specify a 8 that must be met before an alarm can be
triggered by certain events. This specification is not mandatory. Select the
input(s) that will be closed or opened so that the alarm can be triggered with
the Edit button in the "

/ field. The link within this field is an "AND" link. If an input is
disabled but still listed in this field, this condition is recognized as "true" and
thus the alarm is triggered.

Now, specify the time in the field in which the following events must
occur to trigger an alarm.

Within the fields, an "OR" link is created; between the fields an "AND" link is
established. Select the events in the group fields above the respective Edit
button that will trigger the alarm (digital inputs closed / opened, SeeTec
Network I/0 inputs).

Alarms can be triggered via buttons as well. To start an alarm scenario via a
button, configure it in the tab with the same name. These buttons will then be
listed in the lower field % /
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End
Termination of an alarm scenario can take place either by specifying the
2 (= alarm recording duration) or

through additional triggers (open / close digital inputs, activation with the Edit
button).

You can also terminate an alarm by using a function button. This button must

be defined at a later point of time using the Buttons menu option.

Servers
To ensure that cameras start recording in case of an alarm or connect outputs,
edit the actions that are to be applied at the start of an alarm:

The Action selection dialog will be displayed that lists all actions that can be
executed.

Server actions

The following actions are available at the start of the alarm scenario:

e Start alarm recording

*  Move to preset positions

* Close digital outputs

* Send e-mail

If you activate Send e-mail and close the Action selection dialog you can enter

the % andthe 2 for your e-mail.

Note
If you want to send an e-mail you must first specify an SMTP

Server under System Management as well as an
Alarm e-mail address.
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In order to save pre-alarm images for this alarm scenario, e.g. to better light
an event that triggered the actual alarm, you need to specify a time range in
the 8 E field. This time range is added
to alarm recording only if you specified a pre-alarm duration in the Image
recording (Alarm image recording) menu of Camera configuration. The
duration of the pre-alarm is restricted to 3600 seconds.

If you want to change the frame rate you specified in the Image recording
(Alarm image recording) menu of Camera configuration, activate this option
and enter the desired frame rate.

To perform an Action on end of alarm, click on Edit and select the
corresponding action.

Client

Here you specify which alarms a certain user / group may see (Involved
persons), how alarms are displayed in the interface (Visualization), and
whether messages are sent to the client (Message on display, only for alarms
with medium or high priority). In case of alarm you can set the Play sound
option or select Execute external application.

Note
Different sound files are executed for different priorities.

If you want individual sounds to be played for different alarms,
these files must be in .wav format. Copy the files on each client PC
into the

<SeeTec installation directory>/Client/sound directory and replace
all existing standard sounds.

Please note:
Your sound files must be renamed accordingly (low.wav,
medium.wav or high.wav).
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Adding involved persons

1. Click on Edit and select the user / groups that may see the alarm.

2. Confirm with OK.

Play sound

If you enable Play sound, a sound matching the priority of the alarm scenario
is played on every start of an alarm.

Executing external applications

*  Click on Select and select the respective . % file of the desired
application.

. Confirm with Open.

Important
The application must be available on the local client

computer.
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Visualization

There are two types of visualization that can be combined:

Layers and cameras:

Determine which layers and cameras will be displayed in the
corresponding windows in Surveillance Mode. Click on ©

to toggle between normal mode and fullscreen mode. Click on

o to display the layer / camera in the main window or in one of
the additional windows.

Alarm cameras
You can choose between Mark as alarm camera (= red frame around
the camera in case of alarm) and Display flyout window.

Note
Alarms with low priority are immediately terminated when the

alarm ends, i.e. all open dynamic elements (layers, cameras and
flyouts) are closed and the previous layer is recreated. Alarms with
medium / high priority are only terminated upon confirmation.
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4.2.7 Buttons

To be able to start actions such as camera recordings, alarm scenarios or
opening doors through a button, you must add these buttons.

General

Using the General menu option you can change the = button and the
button symbol later on.

The buttons in the button bar are sorted alphabetically in Surveillance Mode.
To use a different sorting, select the desired position of the button.

To assign a keyboard shortcut to the button activate the option and enter your
shortcut. The following keys and combinations of keys are already under use
by SeeTec and may not be used: Escape, F1, F8, F9, F11, F12, CTRL+ 0O, 1, 2,
3,4,S,0.

If you activate the Button is assigned to a camera option, the button is shown
only if you have previously selected the respective camera.

Action

With Action you can specify the action to be triggered if you press a certain
button.

You can Invoke a URL (e.g. switch to another Mobotix camera lens), Execute
an action (open or close digital input, start / end alarm recording ) or

Start / end an alarm. Furthermore, you can start a Patrol or Launch an
external application.

Important

If you want to start an external application by using a button,
the respective software must be installed on the local client
computer.
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4.2.8 Patrols

You can create a patrol in order to automatically display multiple cameras,
preset positions, maps, and layers subsequently for any given period of time.
In addition, you can open or close digital outputs for a certain patrol.

Generating patrols

Create a patrol, specify a = and Edit it.

o In the left window select a camera, layer, action, or a map and insert
them in the 8 / field using drag & drop

. Double-click on the respective position in the window or on Edit if the
camera is to be displayed in an additional window.

. Click on New pause.

. Click on Up or Down to move a patrol position within a group.

Notes
= Adding a group is done simply for maintaining clarity.

= The length of the delay specifies for how long the previously
selected camera, layer or map will be displayed in the desired
window.

= If you wish to show a preset position you need to add the
camera first, followed by the respective preset position.

= To be able to start a patrol in Surveillance Mode, you must
first assign the patrol to a user or a group in the Profiles tab.
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4.2.9 System Management

The System Management menu option enables the generation of automatic
system configuration backups. These backups are stored in ZIP format to save
space and to enable a rapid rebuild of the surveillance environment in the
event of a system failure. With the SMTP Server and Email Management tabs
you can modify the settings for e-mail notification for camera or SeeTec
Service failure and predefined alarm scenarios. Furthermore, you can use
SNMP traps for system error reporting.

Backup (SAPDB)

Using the Use automatic backup option you can specify a point in time in the
designated field for performing a system configuration backup (SAPDB, used in
SeeTec 5 as management and event database). The backup is performed at a
certain time on a daily or weekly basis on the day you chose from the
dropdown list. If no path of location is specified for automatic data backup, the
backup is stored under:

<SAPDB installation directory>/backup

The name of the backup file will correspond to the following nhaming
convention:

C (74 )

If Delete old files is enabled, a maximum of eight backup files is stored.
Manual backup files are generally NOT deleted.

Note
The path of location may not contain spaces or special characters

and must be available locally on the SeeTec server.
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Manual backup

Note
If the client is started on the computer on which the Core services

(basic services) have been installed, you can alter the path of
location by clicking on Edit. The entire path must be available
locally and may not contain spaces or special characters.

Click on Execute backup.

The backup will be started. The name of the backup file will correspond to the
following naming convention:

@4 )

Important

If Delete old files is NOT activated, you will run the risk that
the hard disk storage completely fills up with backup files
after a while.

For this reason, the backup directory should regularly be
stored on a tape storage device or another backup medium
to ensure that all backup files are still available in case of a
hard disk crash.
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Work center calendar

In the work center calendar you can specify the days to be treated
independent of normal weekdays in time templates (e.g. holidays or days off).
Time templates are generated in the Time Management tab and enable the
precise specification of recording periods or times at which alarm scenarios are
started.

Note
The days selected here are addressed as Holidays in time
templates.

The Import holidays button helps you to enter public holidays in the work
center calendar.

If Replace existing holidays is enabled, all holidays already entered are
deleted.

You will find templates for the import of holidays under:

<SeeTec installation directory>/client/calendar

Important

SeeTec takes no responsibility for completeness of the
templates.

/ #
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SMTP servers

To ensure that SeeTec services can report faulty operation or failure of a
camera, the software requires data of an accessible SMTP server.

Enter the data of your SMTP server in the 8 , - , and
8 fields.

You can use the Send test mail button to test all specified data.

Important
Even if the test mail was delivered successfully, you must
click OK or Accept to permanently store the settings.

Email Management

You can specify System addresses to which a notification will be sent in case of
failure.

In addition, you can specify Alarm addresses. These can be selected in the
alarm scenario (Server option). For each alarm scenario you can specify a
subject as well as e-mail text in the scenario itself.

To reduce e-mail traffic to a minimum, the e-mail service is equipped with
flood protection, i.e. e-mails are not sent continuously but only after a certain
dead time:
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1x Once within the next 15 minutes
1 hr Once every hour
0 Immediately (only one e-mail is sent)

An e-mail is sent for the following events:

Service Event Dead time

4 - The fill level of SAPDB is too high 0

Warning (fill level > 90%) 0

Shutdown (fill level > 95%) 0

Automatic SAPDB backup has failed 0

One RE (CM or MDB) has an invalid state 0

4 EntityManager registration has failed 1 hr.

OutOfMemory 1 hr.

EntityManager registration has failed 1 hr.

EntityManager registration has failed 1 hr

Fatal AlarmManager error (CIT only) 0

$& Server ports are already in use 1x

EventManager registration has failed 1 hr.

Zone cannot be mounted 1x

Image storage is not possible 1 hr.

$& Network connection with one component has failed 1 hr.
Write access on disk highly delayed and/or low

throughput 1 hr

Server system time was modified 1hr
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SNMP servers
You can use SNMP traps for system error reporting.
Enter the 6 andchange /1 8 ,1 / 8

and in accordance with the settings required for your SNMP
server.

The messages / error messages that are sent correspond to system e-mail
notifications (chapter 4.2).

Important

Ifthe - ;, - : .
component is installed under Control panel Software
Windows Components Management and Monitoring Tools, you
must enter another port for LocalTrapSendPort.

The default port is 161, which will not work in this case.
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NAT list

To access the SeeTec system via the internet without using NAT, you need to
enable forwarding on your router and/or firewall. The default ports are 60000-
60008.

General

Address translation

For the ) and) / , enter the data of the SeeTec server. For
the 8 % and8 % / , enter the data you entered for forwarding.
Example:
Internal name Internal port
- 0 0
Public name Public port
0,

Then, click on Add new entry.
Repeat this step until you have integrated all ports.
To delete an entry, select it and click Remove selected entry.

If encrypted communication is enabled (also see chapter 2), you need to
enable forwarding for port 60011 and 60012, as well.

Important

When logging in via NAT, the Use NAT translation option must
be enabled during server selection.

When logging in without NAT, this option must be disabled
before login.

To delete an entry, select it and click Remove selected entry.
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EBUS interface

Here you can configure the interface between SeeTec and EBUS (consistent
image transmission system, producer: Accellence Technologies GmbH).

General

EBUS settings

Enable the interface and enter the IP address and the EBUS server's port in
the 8 and 88 fields.

SeeTec settings
In the and 8 fields, optionally enter the IP address of the SeeTec
server and the SeeTec5_ENT service's port (default: 60000).

This information is required if the server can only be accessed via NAT. In this
case, enter the public IP address and the port that is forwarded to the SeeTec
port 60000.

For the 8 , enter the Name of an existing SeeTec user. The image settings
of this user are then used for image streaming (Profiles > User -> Image
settings).

Additionally, enter a $ / for the SeeTec installation.
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4.2.10 Event Management

This tab is used to purge the event database. To ensure rapid search for
events, irrelevant events (e.g. events for which image data no longer exist)
must be deleted from the database at regular intervals. Databases that are
purged with this method deliver higher performance rates during search
operations.

Automatic database deletion

. Activate the Automatic deletion checkbox.

. Specify the time range after which events are to be deleted from the
database.

Note
This time range should correspond to the maximum recording
period of the camera with the longest alarm recording capacity.

Manual database purge

*  Click on Manually deletion to delete all events.

. If you do not want to purge the entire database to be deleted, you
can also just Delete events automatically older than a specific point in
time.
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4.2.11 Web pages

You can use cameras, maps and web pages in layers. This requires a Microsoft
Internet Explorer installed on the client.

Configuring web pages

1. Generate a new web page and enter a =

2. [Edit the web page and enter a . ;1. Alternatively, you can select
another icon.

3. Click the Test button to verify the URL you entered.

The web page can be opened in Surveillance and Archive Mode if the user has
the assigned rights.

You can use the generated web page in a layer. Use drag & drop to add the
page from the User view to the layer window.

Additionally, you can add the web page to the map as an icon.

Double-clicking the icon on the map or directly on the status bar of a displayed
web page will open a flyout window.
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4.2.12 Servers

All SeeTec 5 MultimediaDatabase and CameraManagement servers working in
combination are listed here. To connect individual servers, use SeeTec 5
Administration. Configuration of individual servers must be performed directly
on the respective computers.

Camera Management

CameraManagement servers serve to allocate image files to individual
MultimediaDatabases. They are also responsible for communicating with Core
Services and event handling and deliver all necessary files to the client
computers.

General

Change the = of the Camera Management if you use a combination of
multiple servers in order to assure clear allocation.

Options

Enter the / that is to be used to send and receive SIP messages (default:
60021).

Note
If you change the port, you have to adjust the Brekeke server
configuration accordingly (see chapter VoIP server configuration).
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Multimedia Database

MultimediaDatabases are addressed by the CameraManagement server. They
basically serve to store and deliver image files. You can use any number of
MultimediaDatabases together to be able to realize complex monitoring
projects. The configuration of these databases must be performed on site on
the respective computers using the SeeTec administration tool.

General

Change the = of the multimedia database if you use a combination of
multiple servers in order to assure clear allocation.

The Show stats button opens a window containing information on the image
database load.

Image database load window
To further process the statistics data in another program, click on

Export CSV. A comma-separated file is created which you can import into
Microsoft Excel or OpenOffice, for instance.
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Image data export

Automated image data export

Activate automatic export and enter the path for automatic image database
export in the 42/ / field. The export path must be available on the
SeeTec Server.

(The image database export is configured in the Camera configuration in the
Image data export area).

Select the for automatic export and enter the Password with which
image data will be encrypted.

Manual image data export

You can optionally enter a password with the Change password button. You
can use it as an alternative during image export in Configuration and
Archive Mode.

Use the Delete password button to delete the password.
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4.2.13 Server extensions

CIT service

The CIT service (cash in transit) is available with an extended license.

The surveillance of counting stations is useful to ensure the correct course of
action during counting processes of large sums of cash. The counting process
is documented fully and consistently. The recordings stored in SeeTec 5 are
associated with individual transactions using the interface to the money
counting system's software and additional information is included. For further
information see the manual for the CIT service.

Retail service

The Retail service is only available with an extended license.

This module provides an interface to cashier systems in stores and acts as a
link between business processes and the corresponding video image. By using
search parameters (e.g. receipt numbers, cancelations, revenues exceeding a
specified sum), you can search and view the corresponding image data in the
media database.

For further information see the manual for the Retail service.
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ATM service
The ATM service (automated teller machine connection) is only available with
an extended license.

Its field of application is the surveillance of automated teller machines and
cash recyclers. Transaction related video data that is stored in the archive
enables you to easily view business processes.

For further information see the manual for the ATM service.

LPR service
The LPR service (license plate recognition) is available with an extended
license.

Automated license plate recognition in the video image and matching against a
license plate database enables you to monitor driveways, control boom gates,
manage parking spaces and unloading areas as well as triggering alarms in
SeeTec 5. Alarm scenarios and records can be configured in detail.

For further information see the manual for the LPR service.
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4.3. Surveillance Mode

Surveillance Mode is used to display live images, alarms and patrols as well as
to control PTZ cameras and other peripheral devices such as door openers.
Individual components such as control elements and layers can be hidden or
shown using the Layer menu.

Main menu Map
Camera overview Layer / Camera

Y
g

*

~
PTZ control \

Layer selection

Button bar, VoIP,
patrol (hidden) Alarm list
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You can do the following by clicking the right mouse button in a camera image:

109

Display image information (image size, streaming method)
Close layer
Delete camera (temporary layers only)

Open archive flyout window:

Allows you to view the last 60 minutes (maximum) of the recording
without switching to Archive Mode. Also, an alarm recording of the
currently active alarm is displayed (only during an active alarm if the
corresponding camera started an alarm recording).

Print image
Save image as file (including camera name, date and time).
Start alarm recording

Stop alarm recording
Alarm recording stops automatically after the

2 / you specified in the Configuration Mode
under Hardware -~ <camera> - Camera configuration - Image
recording menu (0 = no recording) unless it is stopped early using
the Stop alarm recording option.
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4.3.1 Map

Maps serve to visualize the area to be monitored. They are inserted as simple
images in Configuration Mode.

The respective cameras are embedded into the graphic image. In this way,
maps can graphically display different company areas reaching from the
premises up to fully automated production lines. In Surveillance Mode, the
user can easily and rapidly navigate through his/her individual maps.

Note
If a camera fails (e.g. no power or network connection), a red cross
is displayed along with the camera symbol.

Sample map

The map shows those cameras in Surveillance Mode that the logged-in user
can operate. The camera image is displayed in a flyout window by double-
clicking on the desired camera. This window is always on top.
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4.3.2 Camera overview (live)

The Camera overview shows all cameras,
maps, layers and web pages for which
the logged-in user has the appropriate
user rights. You can display cameras in
the Camera overview by double-clicking
on the desired camera or using drag &
drop. Simply drag a camera to a
temporary layer.

To maintain clarity in this window and/or

to map a "parent-child" structure, you

can create a new folder in Configuration

Mode in the User view by right-clicking

on a tree level. You can now drag & drop

cameras or maps into the new folder and

thus structure the User view.

If the user has the necessary rights to access a folder, these rights are
propagated to the cameras as well. This means that all cameras in this folder
are displayed in Surveillance and/or Archive Mode. If the user only has the
right to access one camera in a certain folder, all other cameras in this folder
are hidden in Surveillance and/or Archive Mode.

Note
Disabled cameras or cameras for which the user does not have

authorization are not displayed here. If a camera fails (e.g. no
power or network connection), a red cross is displayed along with
the camera symbol.
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4.3.3 Flyout window

Open the flyout window by double-clicking the camera symbol in the map or
by double-clicking the camera in a layer.

You can do the following by clicking the right mouse button in the flyout
window:

. Display the image in actual size.
. Close the flyout window.

. Open archive flyout window:
Allows you to view the last 60 minutes (maximum) of the recording
without switching to Archive Mode. Also, an alarm recording of the
currently active alarm is displayed (only during an active alarm if the
corresponding camera started an alarm recording).

. Print image.

. Save image as file (including camera name, date and time).
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Start alarm recording.

Stop alarm recording.
Alarm recording stops automatically after the

2 / you specified in the Configuration Mode
under Hardware - <camera> - Camera configuration - Image
recording menu (0 = no recording) unless it is stopped early using
the Stop alarm recording option.

Set the current size and position of the flyout as default flyout format.
All later flyouts are displayed with the same position and size.

Use or delete the default flyout format for the camera.

You can also close a flyout window by double-clicking it.
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4.3.4 MPEG / H.264 audio

If you activate MPEG/H.264 audio in Configuration Mode, you can listen to the
audio stream of the camera.

Activating audio stream

Select the camera that you want to listen to. The audio stream starts
automatically.

To adjust the volume, move your mouse over the camera name in the lower
part of the live image. This activates volume control.

Notes
You can only listen to the audio stream if:

* the camera supports audio streaming
. the camera delivers MPEG / H.264 images

* the user has the right to receive audio streams from the
camera
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4.3.5 Patrols

You can perform a patrol in order to automatically display multiple cameras,
preset positions, maps, and layers subsequently for any given period of time.

Starting patrols

Click on the desired patrol in the patrol window.

Click on

Pausing patrols

Click on

Stopping patrols

Click on

Switching positions

Click on or

Automatically repeating patrols

1. Click on the desired patrol in the patrol window.

2. Click on
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Patrol in Surveillance Mode

Notes
If an alarm scenario is triggered, the patrol will be stopped

automatically. After termination of the alarm scenario you need to
restart the patrol manually.

In Configuration Mode patrols must be assigned to the respective
user or group profile.
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4.3.6 Digital zoom

In version 5.0.11 or higher you can digitally zoom the camera image in and
out in Surveillance and Archive Mode.

Activating digital zoom

Click on the left button () next to the camera name.
The magnifying glass icon will turn red. The zoom is activated.

Draw a rectangle in the camera image with your mouse. This area
then zooms in. Optionally you can also use the "+" and "-" keys on
the numeric pad of your keyboard or the mouse wheel.

Draw another rectangle to zoom in further or click on the image to
reset it.

Move the camera image when the zoom is activated by holding down
the mouse wheel button (this button needs to be configured as the
third mouse button). Alternatively you can use the arrow keys on
your keyboard.

To deactivate the zoom function, click on the magnifying glass icon next to the
camera name again. The camera image will obtain its original state.
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4.3.7 PTZ control

With the PTZ control panel you can use the cameras’ pan, tilt and zoom
functions.
If you select a PTZ camera (framed in green) the control window is displayed.

Additionally, you can control the camera yourself by clicking on the image (see
below).

There is another panel below the control panels for the pan, tilt and zoom
functions that is used to control the following:

. Home (position)

. Day switch

. Night switch

o Focus (+ / - / auto)
o Iris (+ / - / auto)

Switching of day / night is possible only with cameras supporting this function.
Preset positions are listed below. They were created for this camera in
Configuration Mode, and the logged-in user has the respective rights to use
them.

As a general rule, you must distinguish between continuous control and
absolute control when controlling PTZ cameras.
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Continuous control

When using continuous control, an image with
crosshairs is displayed. The center of the
crosshairs represents the object the camera
focuses on. By clicking above / below the
horizontal line, the camera will pan up / down,
by clicking right / left of the vertical line, the
camera will pan to the right / left. The distance
between click position and center of the image
will determine the pan speed. The field below the
image ( ) is for using the zoom
function. The same holds true here: The distance
between click position and center of the zoom
area will determine the zoom speed.

Absolute control

When using absolute control, the scroll fields are
displayed. Two of them serve to position the
camera (vertically / horizontally), the third field
is used to set the zoom. You can also adjust the
zoom by using the # and = buttons. If you click
on the buttons or scroll fields further to the
right / left or up / down, the zoom / pan / tilt
speed of the camera is increased / decreased.
Alternatively, you can change the camera
position by clicking inside the operating panel,
e.g. by dragging the red square with your
mouse.
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Control by clicking on the camera image
To activate control in the image click on the icon to the right () on the left

under the camera image (the left magnifying glass icon activates digital zoom,
see the previous chapter). In the center of the image a red cross is displayed.
The distance between click position and center of the cross will determine the
pan speed to the different directions. Use the mouse wheel to activate the
zoom function of the PTZ camera.

To deactivate control, click on the right icon again.

Note
Control by clicking on the camera image is only available if

continuous control was selected for PTZ control!
The continuous PTZ control's Sensitivity can be set in Configuration
Mode during Camera configuration.

4.3.8 Button bar

The button bar shows all function buttons assigned to the user. These buttons
can be used for the following purposes:

. Invoke URL

. Start actions

. Start / stop recording

. Connect digital inputs

o Start / stop alarm scenarios
. Execute patrols

. Start external applications

To integrate buttons, switch to Configuration Mode and select the Buttons tab.
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4.3.9 Alarm list

As soon as an alarm occurs, a popup window is displayed for alarms with
medium / high priority. You can specify the text in the Client option of the
Alarm scenario in Configuration Mode. The buttons have the following
meaning:

Confirm
The alarm is confirmed, deleted from the alarm list, and the next alarm with

highest priority is displayed.

Den

The Zlarm is rejected, deleted from the alarm list, and the next alarm with
highest priority is displayed.

Postpone

The alarm is postponed and marked as postponed in the alarm list. NO other
alarm is displayed until an alarm from the alarm list is restarted by right-
clicking with the mouse or until the alarm is confirmed. This provides the
opportunity to confirm multiple alarms at a time.

However, a new alarm will be displayed.

Note
When the alarm has ended or if another alarm occurs, low-

priority alarms are marked as confirmed and deleted from the
alarm list. These alarms do not have an alarm status.

All open alarms that are associated with the currently logged-in profile are
displayed in the alarm list. Specify the text and background color of the alarm
in the Alarm scenario in Configuration Mode. Every alarm has three different
statuses:

¢ Active

. New

. Postponed

*  Declined (Archive Mode only)

¢ Confirmed (Archive Mode only)
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Active

These alarms are currently active.

New

New alarms are considered as not viewed or as not assessed. They are kept in
the alarm list and are regarded as unprocessed until their status is changed.
Postponed

These alarms have already been viewed and were declared important by the
respective user (e.g. guard) because the user still needs to access these
alarms at a later point in time (e.g. for his/her watch report). These alarms
are kept in the alarm list.

Postponed alarms are declared as open when the program is started the next
time.

Declined (Archive Mode only)

These alarms are deleted from the alarm list and declared as unimportant for
or not associated with the user.

Confirmed (Archive Mode only)

These alarms have been viewed and were deleted from the alarm list.
Confirmed alarms are deleted from the alarm list of all users.
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4.3.10 Automatic layer change

If the number of available cameras exceeds the number of cameras that can
be displayed on the monitor simultaneously, you can instruct the software to
change layers automatically.

Configuring automatic layer change

. Arrange all layers in the desired order using drag & drop.
. Right-click on the tab of the Layer.
. Select Change automatically.

. Select the desired time range after which a layer change should occur.

Note

If an alarm scenario is triggered, the layer change will be stopped
automatically. After termination of the alarm scenario you need to
restart the layer change manually.

Right-click to close the current layer or all open layers in the
current window (layers that are not assigned to the user only).
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4.3.11 Load / save user interface

To ensure that the user interface, i.e. the positions of all tool bars, remains
available, you can locally save the user interface layout. In addition, the
current layout is always saved when terminating SeeTec 5 Surveillance.

Locally save user interface layout

¢ In the main menu, select View.

e Select Save user interface or press CTRL+S.

Note
This layout only applies to the user that is currently logged in.

Restore saved user interface

. In the main menu, select View.

. Select Load user interface or press CTRL+O.

Note
The user interface layout is saved upon termination of the

software. The most recently used layout is displayed when starting

the software again.
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4.4. Event analysis

You can track different actions using the event analysis. These events include
user events, alarm events, and system notifications.

User

For instance, by selecting a specific user you can display the time of his/her
login and the corresponding Windows profile (Windows® login name). In
addition, the user’s SeeTec profile is displayed along with mode changes or
actions taken (e.g. pressing buttons). The logoff time is also displayed.
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Alarms

Alarm events indicate which alarm has occurred at what time. The name of the
user who confirmed, postponed or rejected the alarm is displayed as well.
System

The System option helps you to specifically look for system errors referring to
core services and/or image recording. Export events are also displayed here.
Time range

In the timeline you can specify a time range for your event analysis or choose
between 24 hours and a week.

The following events are saved (these events are displayed in a tooltip):

Delete cameras:
Time, SeeTec user, camera hame, computer

Reconfigure cameras:
Time, SeeTec user, camera name, computer, resolution settings, codec,
compression, bit rate, ring buffer after change

Camera in Archive Mode:
When the play button is pressed: Time, SeeTec user, camera nhame, computer,
camera time

When a camera stops playing: Time, SeeTec user, camera hame, computer,
camera time

Print image:
Time, SeeTec user, camera name, camera time, computer

JPEG Export (Save image as file):
Time, Se€Tec user, camera name, camera time, computer, path

AVI export:
Time, SeeTec user, camera hame, camera duration, computer, path

SeeTec image database export:
Time, camera name, camera duration, target directory
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Notes
You can combine alarms with users and the timeline. The selected

alarm and user events will be displayed within the desired time
frame.

You can specify the maximum number of events to be displayed
in the File menu of the Client configuration.

To show the event analysis results, click on Start request.

To further process the analysis results in another program, click
on Export. A comma-separated file (CSV) is created which you
can import into Microsoft Excel or OpenOffice, for instance.
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4.5. Archive Mode

In Archive Mode you can only show recorded data. In order to select all
relevant image data, you need to select a camera in the Camera overview
(archive) or one of the alarms listed in the Alarm overview field.

Recording periods of the selected camera (framed in green) are displayed in a
time bar in the player.

Camera overview (archive) Layer / Camera

/

| 4 \4

R X

Alarm details Alarm overview Player
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4.5.1 Camera overview (archive)

Use this overview to select cameras. As in Surveillance Mode, cameras can be
shown through drag & drop operations or by double-clicking on them.

Showing camera(s)

To display a single camera, select it in the Camera overview.

To display multiple cameras simultaneously, select a layer in the Camera
overview or, in the Layer menu, click on Add layer and select a layer format.
Now drag & drop the cameras from the Camera overview on the layer.

The Alarm overview shows all alarms that occurred in the past hour. These
alarms can be sorted by priority (low, medium, high), name, status (open,
processed), and date.

By clicking on an entry, all cameras associated to the respective alarm are
listed in the Alarm details.

Use the Comments button in the Alarm details to display comments for the
alarm. All comments are optionally entered in the alarm window in
Surveillance Mode for alarms with medium or high priority.

You can view the images of this camera by double-clicking on the camera in
the Alarm details. If you want to display multiple cameras simultaneously, add
a new layer in the View menu or include the cameras using drag & drop. You
can choose these cameras from the Alarm details or the Camera overview.

To go to the exact time at which the alarm begins or ends, simply click on the
respective column in the Alarm details window.

Use the New request button to open the alarm filter dialog.

This dialog enables you to search the alarm database based on individual
criteria. You can limit the relevant time range (today only, one hour, 24 hours,
one week, specified time range) and specify that only alarms are displayed
that pertain to a selected alarm scenario.
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4.5.2 Player (old)

The player is used to control playback of a selected camera. The following
options are available:

Synchronized Play / Step / Pause Playback speed
mode backward / forward

Voo

A

A

/

Time bar

Synchronizing multiple cameras for the same time

1. Select a layer (View menu -> Add layer).
2. Drag and drop the desired cameras on the Layer.
3. Activate the Synchronized mode.

When starting playback, all displayed cameras are synchronized for the time of
the selected camera (framed in green).

In the time bar you can rapidly search for relevant image material in the entire
recording period. The characteristics are:

*  Green (standard recording)

. Red (alarm recording)
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Clicking on the time bar and scrolling the mouse wheel allows you to zoom
within the recording period. In this way, you can obtain a better overview of
the camera’s recording starts.

Use the right mouse button to Zoom in or Zoom out. Additionally, you can
jump to a specific Time or Display alarms only in the time bar.

Real time playback
If this option is activated, the recorded images are played back in a way that

playback and recording duration are identical. Playback speed is set to 1 (real-
time) to avoid time-lapse and slow-motion effects.

* $ #

Playback every image
If the playback speed is too high, images are skipped and not displayed on the

client. If this option is activated, playback speed is reduced to display every
recorded image.

The zoom function is also supported in Archive Mode.
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4.5.3 Player (new)

The new player interface shows a timeline for each opened camera. The
selected camera's timeline is highlighted.

Synchronized mode .
Real time
Play / Step / Pause playback
backward / forward Playback speed

\Y Y K A4

Update timeline Zoom in / out Jump gaps
(timeline)

In the selected time bar you can rapidly search for relevant image material in
the entire recording period. The characteristics are:

*  Green (standard recording)
. Red (alarm recording)

A speaker icon next to the camera icon in a timeline indicates that there is an
audio recording for this camera. Click on the speaker to set the volume.

Right-click in the timeline to Zoom in or Zoom out or to update the timeline.

Additionally, you can jump to a specific Time or Display alarms only in the time
bar.
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Update timeline
The timeline is updated periodically. Click on Update timeline to immediately
view the newest recorded images.

Zoom in / out

With the zoom function you can continuously zoom in or out. Clicking on the
time bar and scrolling the mouse wheel also allows you to zoom within the
recording period.

Synchronized mode
Activate the Synchronized mode. When starting playback, all cameras are
synchronized for the time of the selected camera.

Playback speed
Select the playback speed (speed factor between 0.1 and 10).

Real time playback

If this option is activated, the recorded images are played back in a way that
playback and recording duration are identical. Playback speed is set to 1 (real-
time) to avoid time-lapse and slow-motion effects.

Jump gaps
With this option active, recording gaps that may occur during alarm recordings
are skipped.
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4.5.4 Extended alarm filters in the Archive

Extended alarm filters can be activated optionally.

In the Archive, right-click on the time bar to filter it so that it displays alarm
durations of specific alarm scenarios only (the 'default’ filter only allows you to
display all alarm recordings of the respective camera).

To enable this option, in the <SeeTec installation directory>/conf/mds.conf.xml
file, add the
entry.

The SeeTec services need to be restarted for this entry to take effect.

Important
Alarms that occurred before making this entry in the
mds.conf.xml file will not be displayed when you filter!
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4.5.5 ISearch

SeeTec ISearch assists your archive searches. If something occurred in a
camera's field of vision you may need a lot of time to search all archive
recordings manually.

With ISearch you can let the client PC search the recorded video data.

Opening ISearch

1. Right-click on a camera image.
2. Select the SeeTec ISearch option.

4.5.5.1 Configuring the search with the Wizard

After opening SeeTec ISearch, the Wizard guides you through various search
options:

Application

[I try to find] ... any kind of motion

This search method searches for all changes in the image within the specified
time range. You can do this for the entire image or in an area that needs to be
defined.

[I try to find] ... a single event

This search method is very fast. It allows you to search image material of
several days within seconds. However, this method only works if a single event
with lasting changes occurred in the cameras field of vision.
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Search method

Events in the entire camera image

Displays all changes as results

Events in an area to be defined

After you complete the setup with the Wizard, you can use the right mouse
button to select the shape of the area and the left mouse button to add one or
more areas to the search.

Fine adjustment

With fine adjustment you can adjust ISearch for the surroundings in the
camera image:
Deadtime

Deadtime states how long after a motion in the image or image area another
hit in the result list is displayed.

Pixel threshold

You can adjust the threshold for a change in the image to represent a motion if
the camera is used in extreme lighting conditions or the

environment / background makes this necessary. The higher the threshold is,
the greater is the image change needed to qualify as a hit.

Object size (pixel)

The object size defines the minimum number of pixels an object must have to
qualify as a hit. The default is 50. This makes sure that image noise does not
cause hits.

After completion of the Wizard, use the time bar and the 5 and to
specify the time range in which to search for changes.

Pressing the Start search button starts the search for changes in the time
range specified.

The Results tab displays all hits. You can Export single images. If you
highlight a hit and Close ISearch, the corresponding time of the hit is
automatically displayed in Surveillance Mode.
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4.5.5.2 Search in Expert mode
You can open the Expert mode in addition to the Wizard with the button of
the same name.

The settings in expert mode are equal to those in the Wizard with the following
exceptions:

Fine adjustment

In addition to the Deadtime in the Wizard you can set the maximum number of
frames. This can accelerate the search considerably as not all recorded images
may need to be searched. The default is 0 (all existing frames are searched).

The maximum pixel limit for interval search only affects searches for a lasting
change. The system constantly compares within the starting point and end
point of the time range to be searched. If the current state of both points
diverges by more than the specified pixel limit, the interval bisection is
interrupted and a serial search with bigger increments is started until the
number goes below the pixel limit again. Then, the interval search continues
from this point.
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Methods

Motion in the entire image

Expert mode only searches in the areas selected by the user.

If this option in activated, motion in areas outside the selected areas is also
highlighted if motion was detected in the selected areas.

After configuration, use the time bar and the 5 and to specify the time
range in which to search for changes.

Pressing the Start search button starts the search for changes in the time
range specified.

The Results tab displays all hits already while searching. You can Export
single images.

At the same time the current hit is automatically displayed in the camera area.
You can Cancel the search at any time if the event you are searching for is
displayed. The hits found up to this point are not lost.

If you highlight a hit and Close ISearch, the corresponding time of the hit is
automatically displayed in Archive Mode.
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4.5.6 Exporting image data

To save or analyze recorded image data outside the SeeTec system, you can
export camera images.

Save image as file

1. Right-click on a camera image.
2. Select the Save image as file option.
3. Select the Location.

The exported image also displays the camera name, date and time.

Save images as AVI file

This export saves the film sequence on the client. The codec for exporting
must be available on the client.

Right-click on a camera image.

Select the Save images as AVI file option.

badi A

Drag the time bar to the desired position.
4. Click on Start or Stop.
The time range to be exported is shown in yellow in the time bar.

5. The bottom area of the dialog contains the Avi settings. These
settings serve to specify the properties of the video to be created. You
can change the Resolution or Frame rate of the video at a later point
in time. In the Compression field, select the codec to use for export.
All codecs installed on your system are displayed.

Click Select to specify the name and the export path for the video
sequence.

6. Click Export to start the export.

139



SeeTec 5

Notes
The maximum AVI file size is 4GB.

Do not export uncompressed images as movies (export of 10
seconds of image material requires approx. 350MB if not
compressed).

Try to avoid the use of codecs installed by default with Windows®.
These codecs lead to low-quality export results.

We recommend to use the DivX codec:

http://www.divx.com

Export images

This export type exports images in the SeeTec image database format and
stores the image data with encryption. The export path must be available on
the SeeTec server. The SeeTec OfflineViewer is required to analyze the
exported images. It is stored in the export directory during export. A CD/DVD
burning tool (Totally Free Burner) is also exported.

Right-click on a camera image.

Select the Export images option.

Drag the time bar to the desired position.
Click on Start or Stop.

Select whether you want to export the Standard and/or Alarm
recording.

u kW

6. Entera 8 for encryption. Alternatively, you can use the
default password that is set in Configuration Mode under Server —
MultimediaDatabase — Image data export — Manual image data
export.

7. Entera/ for export that must be available on the SeeTec server.

To start the export, click on Export.
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Important
The export path must be available on the SeeTec Server for
automatic and manual export.

Exporting to a directory on the SeeTec client is NOT possible!

You can also find the setup files for the OfflineViewer and the
CD/DVD burning tool in the tools directory of the SeeTec
installation.
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5 SeeTec Administration

SeeTec Administration helps you to perform settings for Core services, SAPDB,
and the multimedia database.

Important
All settings will only be adopted when rebooting all services
and/or the computer.

5.1. General Setup

The General Setup section of the administrator tool is only used to manage
distributed SeeTec 5 installations. You can communicate the = 3

and/or the 6 and 8 of the computer on which SeeTec Core services
are installed to the locally installed SeeTec Services. For the main server,
maintain the Local host setting, for the secondary server, enter the IP address
of the main server.

If the server on which the Core services are installed features multiple network
interface cards, you can select the network address to be used for
communication between services. In standard installations, the Automatic
setting is selected since it is the best option for systems with only one network
interface card.

5.2. Core services

To ensure communication between individual services, each SeeTec service
must be assigned a unique port.

The ports listed here are of special importance when setting up firewalls (6.3
Firewalls & SeeTec 5). If an installed application already uses these ports, you
can reconfigure SeeTec 5 to use different port ranges.
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5.3. Database

This tab helps you to administer SAPDB. You can start backups or provide
more space to the database to store events or user data, for instance. Keep in
mind that this backup is a configuration backup only. It does not include a
backup of image material.

5.3.1 Creating backups

Initiate SAP database backup

Start the administration tool on the computer on which SAPDB is installed.

Change to Database and click on Backup.
The backup will be stored under <SAPDB installation directory>\backup.

Initiating backups with SeeTec 5 Surveillance

* Start the SeeTec 5 Client.
* In the File menu, change to the Configuration Mode.
* Select the System Management - Backup tab.

* Click on Execute backup.
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5.3.2 Importing backups

Restoring SAPDB backups

Click on Restore.

Select the desired backup file.
Click on Restore.

Important
The backup to be imported must be stored on a local hard
disk and may not reside on a network drive or share.

The backup file path must not contain spaces or special
characters.
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5.3.3 Enlarging the storage space (adding volumes)

You can add another volume to SAPDB if the database requires more space,
e.g. if you wish to store event data for a longer period of time.

This enlargement of storage space does not affect the image database!

Enlarging SAPDB storage space

1. Enter the additional storage space to be used for enlarging the database
inthethe $ % 42 field.

2. Click on Add Volume.

Additional storage space is immediately available on DISKO0OX in the
<SAPDB installation directory>.

Note
The minimum size per volume is 512MB, the maximum size is
4000MB.

Important
For technical reasons, the size of SAPDB cannot be reduced.

You can add a maximum of four volumes to SAPDB.

You will obtain an estimated duration (in days) about how long the storage
space of SAPDB will last at the current alarm rate by clicking on
How long will the DB last?

Important
Reliable information can only be given if the system is
running at normal load with respect to alarm frequency.
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5.3.4 Setting the SAPDB cache size

If many events occur and alarm load times increase because of this, we
suggest to increase the cache size of SAPDB.

However, this value should be selected with care. It is of no use to increase the
cache size if the main memory available on this machine is not sufficient.

The current SAPDB size is displayed below the Set cache size button. The
cache size should always be larger than the current size of the SAPDB.

Cache size can be increased to up to 1,7GB for large installations with several
thousand alarms every day.

Important

The SAPDB cache size is a system-critical parameter that
should be changed with caution and only if it is really
necessary.

The optimum throughput result is obtained if the entire
database is kept in the cache.
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5.4. Multimedia Database (MDB)

This tab helps you to integrate and modify image database zones. These zones
are paths under which the multimedia database stores image data. These
paths can represent both local and network drives. The specified zone size is
not immediately reserved, but assigned automatically as needed.

5.4.1 Adding zones to the image database

Zones are used to determine the maximum storage depth of the multimedia
database and consequently, of the software. By default, the SeeTec 5 software
does not limit the image database zone. During reinstallation, the default zone
is created in the

<SeeTec installation directory>/re/md/mds/data/

directory. We recommend replacing this zone with a zone on a dedicated
partition.
If the volume of the existing zone is not sufficient, you can add another zone.

Adding an image database zone

Click on Add Zone.

2. Select a folder in which image data will be stored. This folder should
be created on a dedicated partition with a cluster size of 64KB.

3. Enter the size in GB for the image database zone in the 2+
field, and confirm your input with Add Zone.

4. Restart the SeeTec services or the server after adding a new zone.

The storage space of a zone should never be used up completely. Leave a
minimum of 512 MB of free space per camera.

We also recommend not to use up the physical storage space of a partition by
more than 90% as this may decrease the performance of the operating
system.

A maximum of 10 zones should be created. More zones impair the MDB's
performance. Also, we recommend to create a few big zones rather than
several small zones.
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Adding an image database zone (nhetwork drive)
Network drives (SAN, NAS, etc.) cannot be configured with SeeTec
Administration. Close SeeTec Administration and open the
<SeeTec installation directory>/conf/mds.conf.xml

file in an editor. Add the following entry:

o
THE % & " THS %
O ** 0

Specify the full UNC path to the network drive and the zone size (bytes, enter
full gigabyte only). Alternatively, you can enter
"-1" as the size (the entire physical space of this partition).

The SeeTec5_MDB service also requires authorization data for the network
drive (log on information; in the Control Panel under Administrative Tools-
>Services, right-click on the SeeTec5_MDB service, select Properties, and

enter the corresponding information in the Log On tab).

The SeeTec services need to be restarted for this entry to take effect.
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Important

If the storage space assigned to the connected cameras
exceeds the available space of the integrated zones and/or
the hard disk, the database will terminate the recording
process.

The MDB zone's cluster size should be 64KB.

We advice against using a hard disk with USB or fire wire as
MDB zone since this has a very negative impact on the
performance of the SeeTec system.

When creating or modifying image database zones, you can
activate the Unlimited checkbox instead of specifying an
explicit zone size. If the Unlimited checkbox is activated, the
entire physical space of the selected partition is used for the
image database.

149

Notes
By default, the MDB zone is stored under:

<SeeTec installation directory>/re/md/mds/data

For reasons of performance, you should outsource the image
database to another hard disk or a RAID system, for instance.

Under no circumstances should you outsource the image
database on a hard disk connected via USB or Firewire.
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5.4.2 Removing zones from the image database

Removing image database zones

1. Select the desired image database in the Zones field.
2. Click on Remove Zone.

Restart the SeeTec Services or the Server after removing the zone.

Important
The image data of this zone are no longer available in the
SeeTec system, but they are not deleted.

Image data must be deleted manually.
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5.4.3 Editing zones

Editing image database zones

1. Select the desired image database in the : field.

2. In the : field, click on Change and modify the path.

3. To change the zone size, enter the new size in the + field and confirm
by clicking on Change.
Restart the SeeTec Services or the Server after changing the zone.

Important
An image database zone on a network drive cannot be
changed using SeeTec Administration (see chapter 5.4.1).

When modifying an image database zone size, you can
activate the Unlimited checkbox instead of specifying an
explicit zone size. If the Unlimited checkbox is activated, the
entire physical space of the selected partition is used for the
image database.
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6 General notes

6.1. Command line arguments

You can assign multiple parameters to the client when starting the system,
e.g. to start the client in another language or transfer passwords to automate
the start. All arguments are assigned in the format <key>:<value>.

Argument Meaning
(H 1 Change language:

With this key you can start the client in another
language. The following languages are available:
es-es (Spanish), de-de (German), en-us (English),
fr-fr (French), it-it (Italian), ru-ru (Russian), sv-se
(Swedish), tr-tr (Turkish)

/  (H/ 1 Automatic login:
Password for the most recently logged in user

/ (H/ 1 Automatic login:
Second password for the most recently logged in
user (if required)

AutoADLogin Automatic login via Active Directory login data

"% &

"C:\Program Files\SeeTec\client\SeeTec 5.exe" lang.en-us
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6.2. Hot keys

To speed up function calls, the user can use the following hot keys in the
SeeTec 5 Client:

Hot key Meaning

CTRL+1 Switch to Surveillance Mode

CTRL+2 Switch to Archive Mode

CTRL+3 Switch to Report Mode.

CTRL+4 Switch to Configuration Mode
(administrators only)

CTRL+S Save user interface (in Surveillance and
Archive Mode)

CTRL+0O Load user interface (in Surveillance and
Archive Mode)

ESC Switch to fullscreen mode

(title bar and main menu will not be displayed)

F1 Display software manual

F8 Activate prioritized camera control

F9 Deactivate prioritized camera control
F11 Forces unlocking of Configuration Mode

Caution: This may lead to configuration
inconsistencies! (administrators only)

F12 Restore default user interface
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6.3. Firewalls & SeeTec 5

To ensure that the SeeTec 5 software can function properly even in a network
environment with a firewall, multiple ports must be available by default on the
server computer. The port range is 60000-60008 (TCP) and 60007 (UDP).

Furthermore, the TCP alarm ports of the camera managed on the server
computer must be available to ensure alarm handling.

The client must also be available on the ports 60000-60008 (TCP) and 60007
(UDP).

Some cameras use the "RTSP over RTP over UDP" standard for MPEG-4 image
transfer. In this case, the SeeTec server communicates with the camera via
TCP port 554 to determine what is transferred (images / audio, etc). The
server also determines a UDP port for the transfer.

This is why the UDP protocol between the camera and the SeeTec server
should not be blocked!
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6.4. Support inquiries

SeeTec 5 support for customers with maintenance option is free.
Contact our support team by phone.

Customers without maintenance option can contact our telephone support
Monday to Friday from 08.30 to 12.00 and from 13.00 to 17.00 under the
following phone number:

+49 - 7256 - 80860
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6.5. Reporting software problems

If you discover a software error, please contact us by e-mail at any time:
support@seetec.de

Note
Support e-mails can be sent using the System option in the Info

menu. Important information that helps us to identify
configuration errors is simultaneously stored in the clipboard.

Reporting software problems using the client’s main menu

1. In the main menu of the client, select the Info menu.
2. Select the System menu option.
3. Click on Send.

4. 1 and select Insert (alternatively, use the CTRL+V hot key).

5. Attach a description of the problem as well as the log file of the
current day to your e-mail. You will find this file under <SeeTec
installation directory>/log.

Note
The log files contained in this folder may be very large and should

therefore be compressed in a ZIP file, if possible.
This is where you will find the client log files:

Windows XP:
C:\Documents and Settings\<logged-in user name>\Local Settings\
Application Data\SeeTec 5\log

Windows Vista:
C:\Users\<logged-in user name>\AppData\Local\Seetec 5
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6.6. Supported devices

6.6.1 Network cameras

ACTi
ACD-2100, ACD-2200,

ACM-1231, ACM-1232, ACM-1100P Series, ACM-1110P Series, ACM-1100N
Series ACM-1110N Series, ACM-1310P Series, ACM-1430P Series, ACM-1310N
Series, ACM-1430N Series, ACM-3100P Series, ACM-3110P Series, ACM-3100N
Series, ACM-3110N Series, ACM-3211P Series, ACM-3311P Series, ACM-3211N
Series, ACM-3311N Series, ACM-4100P Series, ACM-4100N Series, ACM-4200,
ACM-5600 Series, ACM-5711

CAM-5200P Series, CAM-5220P Series, CAM-5200N Series, CAM-5220N Series,
CAM-5300P Series, CAM-5320P Series, CAM-5300N Series, CAM-5320N Series,
CAM-6500 Series, CAM-6600 Series, CAM-7200P Series, CAM-7220P Series,
CAM-7200N Series, CAM-7220N Series, CAM-7300P Series, CAM-7320P Series,
CAM-7300N Series, CAM-7320N Series,

SED 2120, SED 2140, SED 2320Q, SED 2610

Arecont Vision

AV1300, AV1305 (incl. H.264), AV1355, AV2100, AV2105 (incl. H.264),
AV2155, AV3100, AV3105 (incl. H.264), AV3130, AV3155, AV5100, AV5105
(incl. H.264), AV5155, AV8180, AV8360

Axis

M1011, M1031, M3011, M7001, P1311, P3301, Q1755, Q7401, Q7406, 200+,
205, 206, 206M, 206W, 207, 207M, 207MW, 209,FD, 209MFD, 210, 210A, 211,
211A, 211M, 211W, 212, 213, 214, 215, 216FD, 216MFD, 221, 223 225FD,
231, 232, 233, 240Q, 241Q, 241S, 241SA, 243S, 243Q, 247S, 282, 282A,
2100, 2110, 2120, 2130, 2130R, 2420, 2400, 2401, 2411

Axis (HTTPS support; only for image transfer and control
commands for M-JPEG)

207, 207M, 209FD-R, 211A, 211M, 212, 216FD/FD-V, 221, 223M, 225FD,
231D, 232D, 233D, 240Q, 241Q, 241S, 241SA, 243SA
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Basler
BIP 640c, BIP 750c, BIP 1000c, BIP 1300c, BIP 1600c

Bosch / VCS

Dinion IP-NMC-0455, EX30-IP, EX36-IP, EX80-IP, NWC-495,VG4 AutoDome,
Videojet 10 (no PTZ support), Videojet 1000 (no PTZ support), Videojet X10,
Videojet X20, Videojet X40, VIP X1600, VIP X1 (no PTZ support), VIP X2 (no
PTZ support), VIP 10 (no PTZ support)

Convision

V400, V410, V600, V610, V800, V1200, V1600, V4000

Dallmeier
DF-3000IP/V

Grandeye

Halocam IPC, Halocam IPW

IQinVision

(I/0 function and PTZ control currently not supported on all models)

IQeye IQ040SI, IQeye IQ041SI, IQeye 1Q042SI, IQeye510, IQeye511,
IQeye701, IQeye702, IQeye703, IQeye705, IQeye751, IQeye752, IQeye753,
IQeye755, IQeye802, IQeye803, IQeye805, IQeye811, IQeye852, IQeye853,
IQeye855

JvcC

VN-V25U, VN-V26U, VN-V686U, VN-X35U

Lumenera

(I/0 function currently not supported)
Li045, Le045, Le075, Lel65, Lel75, Le259, Le275, Le375, Le575, Le11059

Mobotix
D12, D12-IT, D12-SEC, D22, D22-IT, D22-SEC,

M1D, M1M, M10D, M10M, M12, M12-IT, M12-SEC, M22, M22-IT, M22-SEC
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Panasonic
BB-C131

BB-HCM281, BB-HCM311, BB-HCM331, BB-HCM403, BB-HCM481, BB-
HCM511, BB-HCM531, BB-HCM515, BB-HCM527, BB-HCM580, BB-HCM581,

BL-C1, BL-C10, BL-C20, BL-C30, BL-C111,

BL-HCM381, BL-HCE481, BL-HCM 311, BL-HCM 331,

KX-HCM230, KX-HCM280, KX-HCM10,

WI-NT304, WI-NT314,

WV-NF302,

WV-NP240, WV-NP244, WV-NP304, WV-NP472, WV-NP1000, WV-NP1004,
WV-NM100,

WV-NS202, WV-NS320, WV-NS950,

WV-NW470, WV-NW474

Sanyo

VCC-HD4000, VCC-XZN600P/XZ600N/ZMN600P/ZM600N (no H.264 support)

Sony
SNC-CM120

SNC-CS3P, SNC-CS10P, SNC-CS11P, SNC-CS20, SNC-CS50P,
SNC-DF40P, SNC-DF50P, SNC-DF70P, SNC-DF80, SNC-DF85
SNC-DS10, SNC-DS60

SNC-DM110, SNC-DM160

SNC-RX550P,

SNC-RZ25P, SNC-RZ30P, SNC-RZ50P,

SNC-Z20P,

SNC-P1, SNC-P5, SNC-M1, SNC-M3

SNT-V704
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Vivotek (no audio support)
FD7131/32, FD7141, 1P7131/32, 1P7138/39, IP7151/52, IP7142, SD7151

6.6.2 VoIP intercom cameras

Schneider Intercom
SIP-2110, SI-Cam 2106

Commend
B-CP-Cam

6.6.3 Input / output devices

Beckhoff

Beckhoff PLC (programmable logic controller)

Advantech
ADAM 6050, ADAM 6050W, ADAM 6052, ADAM 6060, ADAM 6060W, ADAM
6066
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6.6.4 Other

Cameras with audio streaming:
Audio streaming (simplex) support for the following cameras along with MPEG-
4.

ACTi (PCM)
ACD-2100, ACD-2200, ACM-1100, ACM-1231, ACM-1232, ACM-1310, ACM-
3100, ACM-3211, ACM-34x1, ACM-4100, ACM-4200, ACM-5600, ACM-5711,
ACM-7411, CAM-5200, CAM-6500, CAM-7200, CAM-7300, SED-2140, SED-
2320, SED-2610

Axis (G.711, G.726)
207MW, 207W, 210A, 211A, 211M, 211W, 212, 213, 214, 215, 216FD(-V),
216MFD(-V), 223M, 233D, 241SA, 241QA, 247S, 243SA, Q7401

Panasonic (G.726)
WV-NS202, WV-NF284, WV-NP240, WV-NP1000, BB-HCM511, BB-HCM531,
BB-HCM515, BB-HCM581, KX-HCM110, BL-C131, BL-C111

Sony (G.711, G.726)
SNC-CS50P, SNC-DF40P, SNC-DF50P, SNC-DF70P, SNC-DF80P, SNC-RX550P,
SNC-RZ25P, SNC-RZ50P, SNC-P1, SNC-P5, SNC-M1, SNC-M3

Hibis

Cash register systems
Reis

Counting machines

Werner Industrielle Elektronik

Automated teller machines

161



SeeTec 5

SeeTec
#

With the archive you can re-embed the image data you exported with the
image export in the SeeTec system.

#oo*;
Use of SeeTec VoIP modules and SeeTec clients with VoIP functionality.
_ oy

This device type enables you to carry out all network-based input and output
operations.

. Restrict access permissions to specific IP addresses (and/or address
ranges).

. Use as client or server.
. Define input or output data as ASCII text or hexadecimal code.

. Input / output using different network protocols (TCP, HTTP-GET,
HTTP-POST).

A

Automated license plate recognition. A software module integrated in SeeTec is
used for license plate recognition. Also see the manual for license plate
recognition.
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7 Appendix

7.1. VoIP server configuration

Requirements:

>
>

SeeTec license module for audio devices

PBX system:

Brekeke PBX server (free trial version for 60 days available at
http://www.brekeke.com/download/download_pbx_2_0_trial.php).
(Caution: The software requires an installed JAVA version 1.4 or higher.)
Extension(s):

For example Mobotix camera (with VoIP support) or a door intercom
system (Siedle, René Koch AG, Doortello, Elcom) with an integrated
Linksys VoIP module.

The ports 5060 (SIP port) and 7000 and above (RTP, for voice
communication) are used for the communication between the SIP server,
extension, SeeTec server and SeeTec client.

163



SeeTec 5

7.1.1 Configuring the Brekeke PBX and SIP server
(interphone system)

The interphone system consists of 2 components that communicate with each
other: Brekeke PBX server and Brekeke SIP server. These two components are
part of the Brekeke PBX package. Additionally, an extension is required.
Ideally, the PBX server should be installed on the SeeTec server.

Configuration

After installing the PBX server, copy the # F file from the
tools directory of the SeeTec installation to

<Brekeke PBX install directory>\pbx\webapps\pbx\WEB-INF\lib.

This file is required for communication between the SeeTec server and the PBX
server.

Add the following two lines to the <Brekeke PBX installation directory>\pbx\
webapps\pbx\WEB-INF\work\sv\sv.properties file:

seetec.cm.host=<SeeTec server IP>

seetec.cm.port=60021

Then log on to the Brekeke server.
(via Start->Programs->Brekeke->Brekeke PBX Admintool,;
standard user / password: sa / sa)

Click on the TO SIP SERVER button to change to the Dial Plan tab and add a
new rule:

; ( SeeTec SIP

$ /  ( SeeTec SIP server communication

8 1

Enter the following value in the 8 field:
> § >

$request ANINVITE

Enter two valuesinthe $ /7 " 8 field:

> § >

$session de.seetec.v5.sip.SeeTecSIP

$continue true
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Confirm your input with Save.

In the Configuration tab, go to the SIP (General) submenu and set the
REGISTER option to

In the User Authentication tab, create several users in the New User submenu:

Users for the (door) intercom(s) are required. The user name and password
have to match the user at the corresponding intercom.

All other users are SeeTec users that are saved during SeeTec Audio and SIP
configuration (see chapter SeeTec client configuration).

Change to PBX configuration (TO PBX button) to the Users tab and add the
same users here:

Users for the (door) intercom(s) are required. The user name and password
have to match the user at the corresponding intercom.

All other users are SeeTec users that are saved during SeeTec Audio and SIP
configuration (see chapter SeeTec client configuration).

If only one user is to communicate with the intercom, you can assign the
"phone number" of the intercom as the user name for that user. (In this case,
the SeeTec user is also the receiver of the call. This is why he/she should
obtain the "phone number").

If more than one user is to communicate with the intercom, you have to create
each user profile separately.

Also, you have to create an additional user profile that will be used as a group.
For this user, enter all user names in the 5 field that
shall be called when the group user's phone number is dialed.

Disable the Voicemail option for each user and confirm your input with Save.

Go to the Options tab and enter the following in the Advanced submenu:
com.brekeke.tel.sip.stack.InviteHandlerBase.SDP_ADD_TELEPHONE_EVENT=true

Confirm with Save.

Then (re)start the services of the PBX and SIP servers. To start, click the
Restart All or Start All buttons on the main page of PBX configuration.
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7.1.2 Configuring the Linksys VoIP module (extension)

The VoIP module is required to integrate a Siedle or Elcom intercom in the
SeeTec system.

Access the SeeTec VoIP module using a web browser and click on Admin Login
in the upper right corner and then click on Advanced.

On the SIP tab you can optionally change the RTP ports of the RTP

parameters. Their default setting is 9000 (; 8/ ) and 9001 (; 8/
2).
Change to the Regional tab and set the ; $ " of the Control Timer

values (sec) to 0.
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Then determine the communication between the VoIP module and the
interphone system on the Line 1 tab:

In the SIP Settings, you can optionally change the )8 8 . Set the ;
field to no.

In the Proxy and Registration settings, enter the IP address of the interphone
system (Brekeke server) in the 8 2" field. Setthe . 2?2 % 8 2°, .
?&8 2°) $ , 3 T, o ;  and $=

> 8 2 fields to no.
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In the Subscriber Information, enter a nameinthe$ / "= field. The
- )$ and the 8 have to match the user that you created on the

Brekeke server.

]

In the Audio Configuration, set the 8 to G71luandset . 8
"toyes.Set$ 58 > to no.

In the Dial Plan, enter (xxx) asthe $ 8

Note
If no Dial Plan value is entered, a delay occurs between the

keystroke (at a door intercom, for instance) and the activation of
alarm within the SeeTec system

On the User 1 tab, set the 6 : ; value of the Ring Settings to 7.
Confirm your input with Submit All Changes.

Note
To test your configuration, you can use a simple a/b line telephone

to simulate a door intercom.
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7.1.3 Configuring Mobotix cameras with VoIP functionality
(extension)

Note
Currently, the SIP protocol is supported only by Mobotix cameras.

The approach described here includes the configuration of digital
input, i.e. a connection from the Mobotix camera directly (via an
external key) can be established. Not all models support this.

First, add another user on the Brekeke server for the camera (see chapter
Configuring the Brekeke PBX and SIP server)

Access the camera via a web browser and change to the

Admin menu:

In the Serial interface and Modem Setup menu, set the to Data
and set the to I/O Mode.
In the Microphone and Loudspeaker menu, activate the Microphone as

/ and the Loudspeaker as /
In the Phone Call-In menu, activate VoIP only for 8 E) and Intercom
as

Create a new profile in the Phone Profiles menu. Enter the user name as the

8 = % )8 to call when the digital input of the camera is
closed (the user profile has to be created on the Brekeke server previously).
Select SIP audio as the */ Inthe) field, select Accept.
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Several options need to be changed in the VoIP Settings:
First, enable the > )8

In the SIP Settings, enter the . = that you created on the Brekeke
server. The )8 % and the ; match the IP address of
the Brekeke server. Add sip: before the IP address of the ;

Enter the user name and password of the user you created on the Brekeke
server as the )8)% and 8

In the Network settings, you can adjust the )8/ and the ; 8/
In the Audio Message Settings, disable the © ) %
and the 9 ? %

Enable all codecs in the Audio codec settings.
Close the Admin menu and open the Setup menu:

In the General event settings, enable

In the Event settings, activate the Signal Input (SI), set the to closed

(LOW) and set the $ E& to 100.

In the Messages menu, activate the 8 . Set the $
to 5 seconds and mark the SI signal input in the 4 . Select

your SIP telephone profile in the 8 E? 1" field.
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7.1.4 Configuring the Cyberdata VoIP Intercom module
(extension)

First, add another user profile on the Brekeke server for the extension (see
chapter Configuring the Brekeke PBX and SIP server)

Access the intercom via a web browser and go to the SIP Setup menu:

Enter the IP address of the Brekeke PBX server as the )8 and the
? % 8 2°. The default port 5060 is displayed in the ; )88
and 1 )8 8 fields. Change it only if you changed it on the Brekeke
server.

Enter the user name and password of the user profile you created on the
Brekeke server in the respective )8 . )$, )$ and
8 fields.

Set the SIP Registration and Unregister on Reboot options to Yes.

Specify the username that will be called when the intercom button is pressed
in the 8 "= % field. (You have to create this user profil